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Use the following sections to find information on wireframe 
modelling: 

Workplanes (see page 3) 

Points (see page 30) 

Lines (see page 35) 

Arcs (see page 60) 

Curves (see page 79) 
 

Wireframe modelling 
Wireframe objects (points, workplanes, lines, arcs, and curves) are 
described in terms of how to create and edit them. 

The buttons for creating wireframe objects are on the main toolbar. 

 
Selecting one of the following buttons displays the appropriate 
toolbar.  

 Workplane — For full details see Creating a workplane (see 
page 4) and Creating a point (see page 30). 

 Line — For full details see Creating a line (see page 38). 

 Arc — For full details see Creating an arc (see page 60). 

 Curve — For full details see Creating a curve (see page 83). 

 

Wireframe modelling 
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Workplanes 
Use the following sections to find out more about  workplanes: 

What is a workplane? (see page 3) 

Creating a workplane (see page 4) 

Activating and deactivating a workplane (see page 14) 

Editing a workplane (see page 15) 
 

What is a workplane? 
A workplane is an entity that provides a local workspace from which 
you can create geometry. 

 
When creating an object such as a surface or curve, it is often 
easier to create a new workplane and introduce a new local 
workspace rather than perform complex calculations to position it 
correctly with respect to the world workspace. 

Workplanes also enable you to work on a plane that is aligned with 
a specific face of a model. 

 

 An active workplane represents the current workspace. 
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You can have any number of workplanes in your model, but 
only one can be active at a time. You can activate and 
deactivate workplanes at any time. 

 

Master workplanes 
A Master workplane automatically becomes active when the existing 
active workplane is deleted, cut, or deactivated. 

 

Grouped workplanes 
You can group or ungroup workplanes. Ungrouped workplanes (the 
default) are simple 3D local workspaces. Grouped workplanes have 
an association with all the objects created while they are active. For 
example, if you move a grouped workplane, all associated objects 
are moved. 

 

Creating a workplane 
You can create many workplanes in one model. You can switch 
between them by activating and deactivating each one as required. 

When created, a workplane is automatically activated so that any 
new coordinates entered are local XYZ values relative to its origin. 
You may also enter positions on the principal plane of the workplane 
by clicking with the mouse. 

You can also create workplanes which align with objects. If the 
object is wireframe, then the workplane's Z axis aligns along its 
tangent. If it is a surface or a solid, the Z axis of the workplane lies 
along its normal. 

To create a workplane from the Object menu: 
1 Select Object > Workplane from the menu to display the 

Workplane creation menu options. 

 
2 Select the appropriate workplane option. 
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To create a workplane using the toolbars: 

1 On the Main toolbar, select the Workplane button  to display 
the Workplane toolbar at the left of the screen. 

 
2 On the Workplane toolbar, select the type of workplane you want 

to create. 

 Single (see page 6) — Click this button to create a single 
workplane. 

 Multiple (see page 6) — Click this button to create multiple 
workplanes. 

 Geometry (see page 7) — Click this button to create a 
workplane aligned to the selected geometry point. 

 Minimal Depth (see page 8) — Click this button to create a 
workplane aligned with the minimal depth of a selection. 

 Average normal (see page 9) — Click this button to create a 
workplane aligned with the average normal. 

 Top (see page 7) — Click this button to create a workplane 
aligned with the top of a selection. 

 Centre (see page 10) — Click this button to create a 
workplane aligned with the centre of a selection. 

 Bottom (see page 10) — Click this button to create a 
workplane aligned with the bottom of a selection. 
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 Three points (see page 11) — Click this button to create a 
workplane from three points. 

 Current view (see page 12) — Click this button to create a 
workplane from the current view. 

 Point (see page 30) — Click the button to create a point. 
 

Creating a single workplane 

1 On the Workplane toolbar, select the Single  button. 

2 Click in the graphics area to position the workplane on the 
screen. 

The axes of the new workplane lie in the same direction as the 
active workplane (if it exists) or the World workspace (if no 
workplane is active). 

The active workplane (if it exists) is deactivated and the new 
workplane becomes active and current. 

3 Edit the workplane to orientate it to your requirements. 

You can use the graphical handles around the workplane to 
position it. 

You can also position the workplane using the Workplane dialog 
(see page 17). Double-click the workplane to display the 
Workplane dialog. 

 

Creating multiple workplanes 

1 On the Workplane toolbar, select the Multiple  button. 

2 Click in the graphics area to position the workplane on the 
screen. 

The axes of the new workplane lie in the same direction as the 
active workplane (if it exists) or the world workspace (if no 
workplane is active). 

The active workplane (if it exists) becomes deactivated and the 
new workplane becomes active and current. 

3 Edit the workplane to orientate it to your requirements. 

You may use the graphical handles around the workplane to 
position it. 

You may also position the workplane using the Workplane dialog. 
Double-click the workplane to display the Workplane dialog. 
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4 Click in the graphics area again to place another workplane. 
 

Creating workplanes aligned with geometry 

1 On the Workplane toolbar, click the Align to Geometry  
button. 

2 Click a position on an object on the screen to create a workplane. 

A new workplane is displayed on the screen. The active 
workplane (if it exists) becomes deactivated and the new 
workplane becomes active and current. 

If you click on a wireframe object, the Z axis of the workplane 
lies along the tangent of the object at the clicked point. 

 
If the object is a surface or a solid, the Z axis of the workplane 
lies along the normal at the clicked point. To snap to points 
within patches, press and hold the Shift key. 

 
 

Creating a workplane at the top of a selection 
1 Select some objects. 
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2 On the Workplane toolbar, click the Top of selection  button. 

 
The workplane is created at the top of the selection. 

The workplane is positioned relative to a theoretical bounding 
box around the selected objects. 

 

 The bounding box is based on the active workplane. 

 
 

Creating a workplane aligned with minimal depth 

1 On the Workplane toolbar, click the Minimal Depth  button. 

 
2 Select the Origin. 

The cross  icon changes to a tick  icon. 

3 Make your Selection. 

The cross  icon changes to a tick  icon. 
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4 Click OK to create a workplane that is aligned with the minimum 
depth of the selection. 

 

Creating a workplane aligned with average normal 

1 On the Workplane toolbar, click the Average Normal  button. 

 
2 Select the Origin. 

The cross  icon changes to a tick  icon. 

3 Make your axis Selection. 

The cross  icon changes to a tick  icon. 

4 Specify the Surface area option. If ON, the surface area of the 
surfaces in the selection is more important than the number of 
surfaces. In the following example there are 2 large surfaces and 
three minor surfaces in the selection. 

If Surface area is ON, the average normal of the selection is 
indicated by . 

If Surface area is OFF, the average normal of the selection is 
indicated by . 

 
5 Click OK to create the workplane. 
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Creating a workplane at the centre of a selection 
1 Select some objects. 

 

2 Click the Centre  button on the Workplane toolbar. 

The workplane is created at the centre of the selected items. 

 
 

Creating a workplane at the bottom of a selection 
1 Select some objects. 

2 Click the Bottom  button on the Workplane toolbar. 

 
3 The workplane is created at the bottom of the selection. 

The workplane is positioned relative to a theoretical bounding 
box around the selected objects, as shown below. 
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 The bounding box is based on the active workplane. 

 
 

Creating a workplane from three points 

1 On the Workplane toolbar, click the Three Points  button. 

2 Use the Workplane from Three Points dialog (see page 11) to 
define the following points. 

 The Origin. 

 Any point on X Axis. 

 Any point on XY Plane. 
 

Workplane from Three Points dialog 
Use the Workplane From Three Points dialog to create a workplane by 
specifying three points. 

 
After connecting to the Arm, this dialog is displayed automatically 
so you can specify the three points to create a workplane ready to 
digitise any physical geometry. 

A workplane is displayed in the dialog with a selection option for the 
three points: 
 Origin 
 XY Plane 
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 X Axis 

Select each option in the dialog in turn and set the coordinates by 
entering the X, Y, and Z values or clicking in the graphics area. 
When the coordinates are entered, the  changes to . You must 
set the coordinates for all three points. An error is displayed if you 
set coincident points, or if all three points are on the same axis.  

You can enter the coordinates for the points by using the Arm as 
well as by entering them using the keyboard or mouse. 

 Toggle Z-axis direction — Click this button to rotate the Z axis by 
180  around the X axis. The Z axis remains fixed during rotation. 

X, Y, Z — Enter the coordinates for each of the points on the 
workplane. 

 Position — Click this button to use the Position dialog to set the 
coordinates. 

OK — This becomes available only when the coordinates for all 
three points are entered. The workplane is created and the dialog is 
removed. 

 

Creating a workplane aligned with the current view 

1 On the Workplane toolbar, click the Current View  button. 

2 Click a position on an object on the screen to create a workplane.  

3 A new workplane is displayed on the screen, with the XY plane of 
the workplane aligned with the screen.. The active workplane (if 
it exists) becomes deactivated and the new workplane becomes 
active and current. 

Because you can rotate the view to any angle, this command is not 
normally suitable for setting up workplanes when constructing 
accurate geometry. But it can be useful for setting up workplanes 
for machining into difficult areas for example. You can rotate the 
view until you see the area you want to machine into and quickly 
align the workplane to the view. 

 

Creating a master workplane 
To make a workplane into the master, do one of the following: 

 Select Master in the Workplane dialog. Double-click the workplane 
to display the Workplane dialog (see page 17). 

 Right-click the workplane to display the Workplane menu and 
select Master. 
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The master workplane is drawn in a bolder line style when 
deactivated and appears at the bottom of the list in the Workplane 
selector list in the Status bar. 

 You can have only one master workplane. 
 

Creating a grouped workplane 
When a grouped workplane is active, any geometry created is 
grouped with the workplane. A relationship is built between this 
geometry and the workplane. A grouped workplane has a dashed 
line style appearance when deactivated. 

To make an existing workplane into grouped, use one of the following 
methods: 

 Select Group in the Workplane dialog. Double-click the workplane 
to display the Workplane dialog (see page 17).  

 Right-click the workplane to display the Workplane menu select 
Group. 

To stop creating geometry grouped with a workplane, use one of the 
following methods: 

 Deselect Group on the Workplane dialog. Double-click the 
workplane to display the Workplane dialog (see page 17).  

 Right-click the workplane to display the Workplane menu and 
deselect Group. 

 Deactivate the workplane. 
To create all future workplanes as grouped: 
1 Select Tools > Options from the menu to display the Options 

dialog. 

2 In the Options dialog, select the Object > Workplanes page. 

3 Select Grouped. 

4 Click OK. 
 

Adding objects to the grouped workplane 
To add objects to an active workplane group: 

1 Ensure the group workplane is active. 

2 Select the objects. 

3 Select Edit > Add to active workplane group from the menu. 
 

Removing objects from the grouped workplane 
To remove objects from any grouped workplane: 
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1 Select the objects. 

2 Select Edit > Remove from workplane group from the menu. 
 

Creating a temporary workplane 
To create a temporary workplane: 

1 Click the Temporary Workplane  button at the start of the 
Status bar. 

2 Click in the graphics area. 

The temporary workplane is drawn in red (white when selected). 

 
You can have only one temporary workplane in a model. You can 
move it by dragging, but cannot edit it in the normal way. 

The temporary workplane is deleted when you: 

 deselect the Temporary Workplane  button on the Status bar. 

 create a new workplane. 

 activate an existing workplane. 
 

Activating and deactivating a workplane 
You can add geometry relative to a workplane only when it is 
activated. When you are using multiple workplanes in a model, you 
must activate or deactivate them accordingly. 

Only one workplane is active at a time. The active workplane is 
coloured red when deselected and its name is displayed in the 
Workplane list on the Status bar. 

If an active workplane is deactivated and a master workplane 
exists, the master workplane becomes active. If no master 
workplane exists, the World workspace becomes the active 
workspace. 

To activate a workplane: 
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 Select Active in the Workplane dialog (see page 17). 

 Select Active in the Workplane context menu. 

 Select the workplane from the Workplane list on the Status bar. 

To deactivate a workplane: 

 Deselect Active in the Workplane dialog (see page 17). 

 Deselect Active in the Workplane context menu. 

 Select a different workplane from the Workplane list on the 
Status bar. 

 

Editing a workplane 
Use one of the following methods to edit a workplane: 

 Select the workplane and use the graphic handles (see page 24) 
to change the orientation of the workplane. 

 Select the workplane and select Edit > Modify from the menu to 
display the Workplane dialog (see page 17). 

 Double-click the workplane to display the Workplane dialog (see 
page 17). 

 Right-click on the workplane to display the Workplane menu. The 
name of the workplane and the level on which it lies is at the top 
of the menu. 

 
The following options are unique to this menu: 
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Active — Activates or deactivates a workplane. 

Master — Workplane becomes the master. 

Group — Workplane becomes grouped. 

Locked — Locks or unlocks a workplane. 

 Rename a workplane using the Workplane list on the Status 
bar. Click to highlight the text and input a new name. The 
new name is saved automatically. 

 

Workplane selector 
The Workplane list  on the Status bar enables you to activate 
and deactivate workplanes. The name of the active workplane is 
displayed in the list. If no workplane is active, World is displayed. 

To activate a workplane, select it in the list. Any existing active 
workplane becomes inactive. 

To deactivate all workplanes, select World from the list. 

Right-click on the Workplane list to display a menu: 

 
 Instrument — Selects and instruments the active workplane. The 

current selection now contains only the active workplane. 

 Unblank — Select this option to unblank the active workplane. 

 Modify — Select this option to open the Workplane dialog (see 
page 17) for the active workplane. 

If you enter a name in the list, the workplane with that name 
becomes active. If no workplane has that name then the name of 
the currently selected workplane changes to the name entered. 

The names of the workplanes (except Master, World, and 
Temporary) are sorted alphabetically in the Workplane list. 

The Master workplane is always displayed at the bottom of the list. 
If no master workplane exists, the World workplane is displayed at 
the bottom. 
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You can use a filter to display only certain names in the Workplane 
list. Enter a Filter pattern on the Workplane page of the Options 
dialog. 

 

Workplane dialog 
Use the Workplane dialog to edit a workplane. 

 
Name — Enter the name of the workplane. The name of the 
workplane is used in macros to identify a workplane. The name that 
is given to a workplane can be used in many ways - for example, it 
can indicate the job that is used in. 

Active — Select this option to activate the workplane. 

Master — Select this option to make the workplane the Master 
workplane. 

Group — Select this option to group the workplane. 

  Lock/Unlock — Use these toggle buttons to lock or unlock the 
workplane. 

Ensure that the Locked  icon is displayed to lock a workplane. You 
cannot delete or edit a locked workplane. This is particularly useful 
if a workplane has been set up for a specific purpose and you wish 
to avoid accidentally changing it. 

When you lock a workplane, its graphical handles and the options 
on the Workplane dialog are unavailable. 

Ensure that the Unlocked  icon is displayed to unlock a workplane. 



 

18 • Wireframe modelling PowerSHAPE 2015 R2 Reference Help  

The following section of the dialog contains the plane editing 
options. 

 
These options enable you to: 

 define the workspace in which to edit the workplane. 

 move the workplane's origin. 

 change the direction of the workplane's axes. 

 twist the workplane about its axes. 

Plane-editing options are also used in dialogs of other items such as 
primitive surfaces. 

Alignment — Select the alignment of the workplane from the list.  

 

 Geometry — Select this option to align the workplane to the 
selected geometry (see page 19). 

 Current View — Select this option to align the XY plane of the 
workplane with the current view.  

 Minimal Depth — Select this option to align the workplane so that 
the workplane is set at the minimum depth of the geometry (see 
page 21). 

 Average Normal — Select this option to align the workplane to 
the average normal of the selected geometry (see page 20). 

 Control Section — Select this option to align the workplane with 
a control section to minimise undercuts (see page 21). 

OK — Saves the edits carried out on the workplane and closes the 
dialog. 

Cancel — Closes the dialog without saving any changes. 
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Editing a workplane - Align to the selected geometry 
Align the Z axis of the workplane with the tangent of the object at 
the clicked point. 

1 Open the Workplane dialog (see page 17). 

2 Select the Geometry  option from the Alignment list  

3 Click a point on the wireframe. 

 
4 The workplane is aligned as shown below: 

 
If the object is a surface or a solid, the Z axis of the workplane 
aligns with the normal at the clicked point. 
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You can snap to points within patches by using  on a point on a 
surface like the one below: 

 
The workplane is aligned as shown below: 

 

 The workplane does not move, it rotates its axes. 
 

Editing a workplane - Align with average normal 

1 Select the Average Normal  option from the Alignment list on 
the Workplane dialog (see page 17). 

2 The Align with average normal dialog is displayed. 

 
Selection — Select the objects to be used for the workplane 
orientation. The cross  icon changes to a tick  icon. 
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Surface area - If ON, the surface area of the surfaces in the 
selection is more important than the number of surfaces. In the 
example there are 2 large surfaces and three minor surfaces in 
the selection. 

If Surface area is ON, the average normal of the selection is 
indicated by . 

If Surface area is OFF, the average normal of the selection is 
indicated by . 

 
3 Click OK. 

 

Editing a workplane - Align with control section 

1 Select the Control Section  option from the Alignment list on 
the Workplane dialog (see page 17). 

2 Use the dialog to align an existing workplane with a section. 

 
3 Selection — Select the objects to be used for the workplane 

orientation. The cross  icon changes to a tick  icon.. 

4 Click OK. 
 

Editing a workplane - Align with minimal depth 

1 Select the Minimal Depth  option from the Alignment list on the 
Workplane dialog (see page 17). 
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The Align with minimal depth dialog is displayed. 

 
Selection — Select the objects to be used for the workplane 
orientation. The cross  icon changes to a tick  icon. 

2 Click OK to align the workplane with the minimum depth of the 
selection. 

 

Plane-editing options 

 
To define the workspace in which to edit the workplane: 

Use the Workspace list to select either World or Workplane. World 
is the world workspace and Workplane is the workspace defined 
by the active workplane. 

To move the workplane’s origin: 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

To change the direction of the workplane’s axes: 
1 Click the button of the axis you want to change (Axis options). 

2 Complete the Direction dialog (see page 23). 

3 Click OK. 
To twist the workplane about its axis: 
1 Click the button of the axis you want to twist (Twist options).  

2 Use the Calculator dialog to input the twist value 

3 Click OK 
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Direction dialog 
Edit the direction of the selected item using the Direction dialog. A 
direction is defined in terms of a unit vector. 

 
Workspace — Select the workspace in which to define the direction. 

Align the selected item to the chosen axis, using the following 
buttons: 

 Positive X axis 

 Positive Y axis 

 Positive Z axis 

 Negative X axis 

 Negative Y axis 

 Negative Z axis 

Direction — Enter the X, Y, and Z coordinates for the unit vector. 

Apparent Angle — The apparent angle of the unit vector from the 
axis of the plane shown by the icon. The button next to each field 
raises the calculator that allows you to enter more complex 
expressions. 

  

 If an item is selected on the screen, the unit vector will align 
with that item. How the vector aligns with the item depends 
upon the item and where it is selected. For example, selecting 
an arc at its centre aligns the vector perpendicular to the arc, 
whereas selecting the arc itself aligns the vector with the 
tangent to the arc at the selection position. 

OK — Saves the edits carried out on the direction of the selected 
item and closes the dialog. 
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Cancel — Closes the dialog and discards any changes made. 
 

Graphically editing workplanes 
1 Select the workplane to display its graphical handles. 

 
2 Select the handle for the edit you wish to carry out and drag it to 

the required position. 

For each graphical edit, the handle to select is shown below. 
Moving the workplane’s origin: 

 
Select the handle  to move the workplane's origin. 

The coordinates of the origin of the active workplane are 
displayed (in red) in the Status bar, next to the Workplane drop-
down list. 
Changing the direction of an axis: 

 
Select a handle  to change the direction of the X, Y, or Z axes. 
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If the mouse button is released over an item, then the axis 
points directly to that item. 
Moving the workplane along one of its axes: 

 
Select a handle  to move the workplane along the X, Y, or Z 
axes. 
Twisting it around one of its axes: 

 
Select any blue handle  to twist the workplane around its X 
axis. 
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Select any green handle  to twist the workplane around its Y 
axis. 

 

Select any red handle  to twist the workplane around its Z 
axis. 

If the mouse button is released over an item, then the rotation 
snaps to that item. For example if the handle at the end of the Y 
axis was dragged and dropped over an item, then looking down 
Z axis, the Y axis would be pointing directly at that object. 

 

Editing a workplane - Aligning with an inclined face on the model 
To align an existing workplane with an inclined face on your model: 

1 Select the workplane to display its graphical handles. 
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2 Move the workplane by snapping it to existing geometry on the 
inclined face. 

 
The workplane moves to its new position. 

 
3 Drag one of the workplane's axes to point towards another piece 

of existing geometry. 
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The direction of the X-axis is changed so that it lies on the 
inclined face. 

 
PowerSHAPE makes its best guess as to how to align the other 
two axes (changing them as little as possible). 

4 To align the other axes on the inclined face, twist the workplane 
about the axis that has just been positioned. 

 
The workplane is twisted around its X-axis so that the Y-axis lies 
on the inclined face. 
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 If we had dragged the Y-axis instead of twisting the 
workplane about its X-axis, the X-axis would have moved. 

The workplane is now aligned with the inclined face on the 
model. You may now work directly on the inclined face of your 
model. 
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Points 
Use the following sections to find out more about  points: 

What is a point? (see page 30) 

Creating a point (see page 30) 

Setting the options for points (see page 31) 

Editing a point (see page 32) 

Editing the mark used by multiple points (see page 33) 
 

What is a point? 
A point is an object representing a position in the workspace. It is 
marked using a small cross enclosed in a circle. 

You can snap other objects onto points. 

For example, if you have three points in the workspace 

 
you can create two lines by snapping onto the points. 

 

 Many CAD systems require point objects to be created 
whenever a position is specified for an object such a line or a 
surface (except for the very simplest method of defining a 
position). PowerSHAPE provides powerful ways of specifying a 
position as part of every command. Therefore explicit point 
objects are not usually required. Nonetheless, they can be 
useful to mark key locations, or for imported or digitised point 
data. 

 

Creating a point 

1 On the Workplane toolbar, click the Point  button. 
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2 Click in the graphics area to create points. 

 

3 When you have finished creating points, click the Select  
button to exit point-creation mode. 

 

Setting the options for points 
1 Select Tools > Options from the menu to display the Options 

dialog. 

2 In the Options dialog, select the Object > Points page. 

 
3 Select the settings to be used when creating and using points. 
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Default mark type — Select a symbol to represent the mark from 
the drop down list. The possible options are: 

 
Draw points when drawings printed — If selected, points are drawn 
when you print a drawing. 

4 Click OK. From now onwards, new points use the mark you 
selected. 

 

Editing a point 
1 Use one of the following methods to display the Point Editor 

dialog (see page 32) and edit a point: 

 Select a point and select Edit > Modify from the menu. 

 Double-click the point to display the dialog. 

 Right-click the point and select Modify from the menu. 

2 Use the options on the Point Editor dialog (see page 32) to edit 
the position and the mark of the point. 

 

Point Editor dialog 
Use this to edit the selected point. 
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 Use the box selection technique to select a different point to 
edit. The information on the dialog is updated to reflect the 
new selection. Edit the newly selected point in the normal 
way. 

 
Name — Enter the name of the selected point. 

 Mark type — Select the symbol used to represent the mark of 
the selected point. 

X, Y, Z — Enter the coordinates of the selected point. 

 Position — Click this button to display the Position dialog, which 
enables you specify the coordinates of the point. 

OK — Applies the changes entered in the dialog to the point and the 
dialog is removed. 

Cancel — Removes the dialog without altering the point. 
 

Editing the mark used by multiple points 
You can edit the mark used by multiple points. 

1 Select two or more points. 

2 Select Edit > Modify from the menu to display the Multiple Point 
Editor dialog. You can also double-click the selected points. 

3 Use the Multiple Point Editor dialog (see page 33) to edit the 
marks. 

 

Multiple Point Editor dialog 
Use this to edit the mark of the selected points. 

 
Mark type — Select a symbol from the list to represent the mark of 
the selected points. 
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OK — Applies the changes to the selected point and removes the 
dialog from the screen. 

Cancel — Removes the dialog without altering the point. 
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Lines 
Use the following sections to find out more about  lines: 

What is a line? (see page 35) 

Creating a line (see page 38) 

Editing a line (see page 47) 

Chamfers (see page 52) 
 

What is a line? 
A line is the shortest path between two points. It is input by 
entering its start and end positions. 

The following methods of line creation exist: 

 Single lines 

 Continuous lines (default) 

 Rectangles 

 Polygons 

 Box around selected items 

 Shortest distance between two objects 

 Chamfers 

You may also create lines which are tangent to arcs. 

 
 

Single lines 
Single lines are created between a distinct pair of points. 
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Continuous lines 
Continuous lines are lines in which the end of the previous line 
becomes the start of the next line. 

 
 

Rectangles 
Rectangles are constructed from four lines, and are created by 
entering two positions. The first position defines the top left corner 
and the other the bottom right corner. 

 
Rectangles are constructed of four individual lines, which have 
coincident points. 

 When you edit the rectangle, only the lines are edited and not 
the rectangle. 

 

Polygons 
You create polygons by entering start and end points. When you 
enter the end point, a polygon is created. Choose one of three 
polygon creation methods from the Polygon dialog (see page 42). 
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Selection box 
You can create a bounding box around the current selection. 

 
 

Shortest line between two objects 
A line is created at the shortest distance between two selected 
objects. 

 
 

Introduction to Chamfers 
A special case of line drawing is chamfers. This allows creation of 
lines between two lines providing certain details are given. 

Suppose we have two lines as shown below: 
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A chamfer between these two lines is shown below . The two 
original lines can be trimmed back to the chamfer . 

 
 

Creating a line 
To create a line: 

1 Select Object > Line from the menu.  

The line creation submenu is displayed: 

 

This is equivalent to clicking the Line  button to display the 
Line creation toolbar. 

 
2 Select a Line creation type. The following options are available: 
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 Single — Click this button to create a single line. 

 Continuous — Click this button to create a continuous line. 

 Rectangle — Click this button to create a rectangle. 

 Polygon — Click this button to create a polygon. 

 Selection box — Click this button to create a selection box. 

 Shortest — Click this button to create the shortest line 
between two selected objects 

 Chamfer — Click this button to create a chamfer 

 Untrimmed chamfer — Click this button to create an 
untrimmed chamfer. 

 

Creating a single line 

1 Click the Single  button on the Line toolbar. 

2 Input positions to create your lines. 

As you enter positions, a rubber banded line is displayed from 
the start position of a new line to the current cursor position. 

The angle and length of the line from the horizontal are also 
shown, depending on whether gridding is set on the Options 
dialog. For further details, see Blanking and Grid (Menus and 
Toolbars). 

 
 When you move the cursor, the angle and length of the line 

are displayed. These values change as you move the cursor. 
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When the end position of a line is entered, the rubber banded 
line disappears. It is displayed if you enter the start position of a 
new line. 

 

Creating a continuous line 

1 Click the Continuous  button on the Line toolbar. 

2 Input positions to create a series of continuous lines. 

As you enter positions, a rubber banded line is displayed from 
the last position entered to the current cursor position. 

The angle and length of the line from the horizontal are also 
shown, depending on whether gridding is set on the Options 
dialog. For further details, see Blanking and Grid (Menus and 
Toolbars). 

 
 When you move the cursor, the angle and length of the line 

are displayed. These values change as you move the cursor. 

If you press the Undo button , only the last point entered is 
removed from the screen. 

3 To stop creating a series continuous lines, do one of the 
following: 

 Click on top of the last position entered. 

 Click the Select button . 

 Choose any option from the Line creation menu. 
 

Creating a rectangle 

1 Click the Rectangle  button on the Line toolbar. 

2 Input two positions to create a rectangle. 
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After entering the first position, a rubber banded rectangle is 
displayed from the start position to the current cursor position. 
The dimensions of the rectangle are also displayed. When the 
end position is entered, a rectangle is created. 

 

 As you move the cursor, the size of the rectangle changes. 

 You cannot create a rectangle that has a side of zero 
length. 

To stop creating rectangles, do one of the following, 

 Click the Select button . 

 Choose an option from the Line creation menu. 
 

Creating a polygon 

1 Click the Polygon  button on the Line toolbar. 

2 Enter the number of sides for the polygon. The minimum is 3. 

3 Choose one of three methods in the dialog to create the polygon. 
Whichever method you use, you must enter two points. 

After entering the first point, a rubber banded polygon is 
displayed from the start position to the current cursor position. 
The dimensions of the polygon are also displayed. 

When you click the end point, a polygon is created. 

4 If you want to create a composite curve, select the Create 
composite curve option. 

5 If you want the polygon to have fillet arcs, specify the radius in 
the Fillet radius box in the Polygon dialog (see page 42). 
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Polygon dialog 
Use this dialog to create a polygon. 

 
Number of sides — Enter the number of sides for the polygon. The 
minimum is 3. 

Choose one of three methods in the dialog to create the polygon. 
Whichever method you use, you must enter two points. 

After entering the first point, a rubber banded polygon is displayed 
from the start position to the current cursor position. The 
dimensions of the polygon are also displayed. When the end point is 
entered, a polygon is created. 

Centre point and corner point — Click the centre point and drag the 
cursor to the corner point to create the polygon. 

 
Centre point and edge midpoint — Click the centre point and drag the 
cursor to the mid-point of an edge to create the polygon. 
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Edge points — Click the start and end points of an edge to create 
the polygon. The Flip option becomes available if you choose this 
method. 

 
Flip — This option becomes available when you select the Edge 
points method. If selected this flips the centre of the polygon to lie 
on the other side of the defining edge as it is created. 

 
Create composite curve — Select this option to create a composite 
curve automatically from the lines and arcs of the polygon you want 
to create. 

Fillet radius — Enter a radius to create fillet arcs between each 
straight edge of the polygon. If set to zero, no arcs will be created. 

The example below shows two, five-sided polygons. The polygon on 
the left was created with a Fillet radius of 0. The polygon on the 
right was created with a Fillet radius of 4. 

 
OK — Removes the dialog. 

 

Creating a selection box 
1 Select a group of objects. 
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2 Click the Selection Box  button on the Line toolbar. 

A bounding box is created around the selected objects. 
 

Shortest distance between two objects 
1 Select two objects. 

2 Click the Shortest  button on the Line toolbar. 

This measures the distance between the two selected objects and 
creates the shortest line between them. 

 
A line is created at the shortest distance between the two 
objects. 

The types of objects that can be selected are: arcs, lines, curves, 
composite curves, surfaces and points. This can be used instead of 
the Measure minimum distance button on the calculator in order to 
create a line at the distance measured. 

 

Lines tangent to arcs 
There are 3 different ways of creating a line tangent to an arc. 
These are: 

 creating a line with the start position already defined. 

 creating a line with start position as a tangent point on the arc. 

 creating a line between two arcs. 

If you want to create a line tangent to an arc when its start position 
is already defined, its second position is defined by clicking the arc. 
The arc is automatically trimmed to where the line is tangent with 
it. 

The position at which you select the arc is important, because it 
decides: 

 where the tangent solution is. 

 which portion of the arc to trim. 
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For example, suppose you have a start position of a line  and an 
arc as shown below: 

 
In this case, the line is tangent to two positions on the arc . 

 
Select the arc at a position nearest to the required tangent. 

 The arc has three key points (its end points and midpoint) 
which are used to snap on to. If you select any of these key 
points on the arc, the end of the line is positioned there and 
no tangency position is found. To find a tangency point on an 
arc, hover the cursor over the arc until the word 'Tangent' 
appears. 

If you require the top tangent, then the arc is selected in any of the 
positions (apart from the arc’s key points) shown below. 
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The selection positions lie on either side of the position where the 
line falls tangent to the arc. Which side of the arc is selected 
determines how the arc is trimmed. If the arc is selected to the left, 
it is trimmed as shown below. 

 
If the arc is selected to the right, it is trimmed as shown below. 

 
You can click the arc first and then input the end position of the 
line. The tangent on the arc is determined in the same way in both 
cases. 

You can also create a line which is tangent to two arcs. A line 
tangent to both arcs is given in the figure below. 

 

 For a full arc (circle), its start and end points move to coincide 
at the position where the line is tangent to it. 

If the tangent position lies off the arc, then the nearest end 
point of the arc to the tangent position extends to this 
position. 

Line and arc must lie in the same plane. 
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Creating a line tangent to an arc 

1 Click the Single  button or the Continuous  button on the 
Line toolbar. 

2 Input positions to create your lines and where you want a line 
tangent to an arc, select the arc instead of entering a position. 

 

Editing a line 
Use one of the following methods to edit a line: 

 Select the line. 

 Use the default graphical handles to move it (see page 47). 

 Use the workplane handles to move it (see page 49). 

 Select Edit > Modify to display the Line Editor dialog (see page 
49)  

 Double-click the line to display the Line Editor dialog (see page 
49). 

 Right-click the line and select Modify on the Line context menu to 
display the Line Editor dialog (see page 49). The name of the line 
and the level on which it lies is displayed at the top of the menu. 

 
 You can also simultaneously edit multiple lines (see page 51). 

 

Graphically moving a line (default handles) 
1 Select a line. 
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2 Right-click on the line and select Default graphic handle from the 
menu. 

 
3 To edit the line, drag the various handles : 

 Use the spherical handles  to move a line point freely. 

 Use the arrow tip handles  to move a line point along the 
direction of the line. 

 
Moving the cursor over a handle highlights the handle, indicating 
that you can move it. 

If you select the line at a position other than a handle, then the 
whole line moves to the new position. This is illustrated below: 
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Graphically editing a line (workplane handles) 
1 Select a line. 

2 Right-click on the line and select Workplane graphic handles from 
the menu. 

 
3 To edit the line, drag the handles: 

 Use the workplane spherical handles  to move a line point 
freely. 

 Use the workplane arrow handles  to move a line point 
along a fixed axis. 

 
Moving the cursor over a handle highlights the handle, indicating 
that you can move it. 

 

Line Editor dialog 
Use this dialog to edit a line. 

 Change the line selection when the dialog is displayed by 
clicking a different line. Edit the newly selected line in the 
normal way. 
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 The Line Editor dialog is also used to edit multiple lines (see 
page 51), with a number of slight differences. 

 
Name — Displays the name of the selected line. You may also use it 
to edit the name. 

Reverse — Click this button to reverse the line so that the start 
coordinates become the end coordinates and the end coordinates 
the start. 

Workspace — Enables you edit the line in world, workplane, or 
relative workspace. 

 The relative workspace has its origin at the start of the line 
and its axes aligned with the current workspace. 

Length — Enter the length of the line. If you edit the existing length, 
the end of the line moves to increase or decrease the length. 

Start — Edits the start coordinates of the line. 

End — Edits the end coordinates of the line. 

Angle — The angle of line is defined in terms of apparent and 
elevation angles on the selected plane. 

 — Use the plane selector to change the selected plane. 

Apparent — The apparent angle is measured between the projection 
of the line onto the selected plane and an axis of the plane . The 
axis used is the X axis if the selected plane is XY, Y if it is YZ and Z 
if it is ZX. 
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Elevation — The elevation angle is measured between the line and 
the projection of the line onto the selected plane . 

 
OK — saves the edits carried out on the line and removes the dialog 
from the screen. 

Cancel — Removes the dialog and discards any edits carried out on 
the line whilst it was displayed. 

 

Editing multiple lines 
To edit multiple lines at the same time: 

1 Select a number of wireframe lines that you want to edit with 
one of the following methods: 

 Press and hold the Shift key and click the lines. 

 Press and hold the Ctrl key and click the lines. 

 Click and drag the cursor over the lines. 

2 Right-click one of the selected lines, and select Modify. 

 
The Line Editor dialog (see page 49) is displayed. It is similar to 
that of editing a single line, with the following differences: 
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 — The properties that differ between the selected lines are 
highlighted in pink. 

 

 — The range of values is displayed when you hover the cursor 
over a property. 

 

 You can also double-click one of the selected lines to 
display the Line Editor dialog. 

3 Edit the properties. 

4 Click OK to apply the changes to the selected lines and close the 
dialog. 

 You can change your selection of lines whilst the dialog is 
displayed by selecting new lines in the graphics area. Any 
edits that you made to your initial selection are kept. 

 When multiple wireframe lines are selected graphical 
instrumentation is only displayed whilst the Line Editor dialog 
is displayed 

 

Chamfers 
A chamfer is a special line created between two lines (see page 54). 

Two chamfer options are available:  

 lines are trimmed back to the chamfer   
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 lines are left untrimmed . 

 
A chamfer is defined in one of the following ways: 

 Angle Distance (default) — angle from the first line  and its 
distance along the first line  (measured from the point 
intersection of the two lines) 

 

Angle Length — its length  and angle  from the first line. 

 
 Distance Along — distances along both lines  (measured from 

the point of intersection of the two lines) 

 
Specify the default chamfer type and size using the Options dialog 
(see page 54). 
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 You can also:  

 create custom chamfers by specifying the line length and 
angle (see page 55). 

 create a chamfer by specifying the line length or angle (see 
page 56). 

 

Creating a chamfer 

1 Click the Chamfer  button or the Untrimmed Chamfer  
button on the Line toolbar. 

2 Select two lines or click the intersection point of two intersecting 
lines. 

On the screen, a default chamfer is added to your two lines. 

If the two lines cross, the chamfer is created in the same 
quadrant where you click the two lines.  

3 Edit the chamfer as necessary. You are still in chamfer creation 
mode and can continue creating chamfers as required. 

 

Setting the default chamfer 
Use the Options dialog to specify the default type of chamfer to 
create and the default values. 
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1 From the Tools menu, select Options > Object > Lines to display 
the Lines page. 

 
2 Specify the chamfer options: 

Default Creation Mode — You can set the default chamfer creation 
mode so that when you create a chamfer, this type of chamfer is 
automatically created. 

Default length/distance — This is the length or distance used by 
the definition of the chamfer. 

Default angle — This is the default angle of the chamfer with the 
first line when the Default Creation Mode is Angle-Length or Angle-
Distance. 

3 Click OK. 
 

Creating a custom chamfer 
Create a custom chamfer between two connected lines: 

1 Draw two connected lines.  

2 Click the Chamfer  button.  
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3 Enter values in the command line. For example, the following 
specifies a line length of 50 and an angle of 30: 

l 30 
a 30 

4 Press and hold the Ctrl key and select the two lines to create the 
chamfer. 

 

Setting the length or angle of the next chamfer 
Set the length or angle of the next chamfer as follows: 

1 Create two lines. 

2 Click the Chamfer  button. 

3 Enter one of the following: 

length xx 

angle xx 

where xx is the required length or the angle. 

4 Select the lines. 

The chamfer is created with the length and angle that you specified. 
 

Editing a chamfer 
A chamfer is not edited like an ordinary line. It has its own special 
editing features that enable you to change its definition from one 
type to another. 

1 Double-click the chamfer to display the Chamfer Editor dialog. 
(see page 56) 

2 Use the dialog to specify the editing of the chamfer. 
 

Chamfer Editor dialog 
Use this dialog to edit a chamfer. There are four tabs to change the 
type of chamfer definition. 
 Angle-Length 
 Angle-Distance 
 Distance Along 
 Line 
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Angle Length — Converts the chamfer to an Angle-Length chamfer. 

 
The figure below shows how the chamfer is defined using this 
page. 

 
Angle Distance — Converts the chamfer to an Angle-Distance 
chamfer. 
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The figure below shows how the chamfer is defined using this 
page. 

 
Distance Along — Converts the chamfer to a Distance Along chamfer. 

 
The figure below shows how the chamfer is defined using this 
page. 
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Line — The chamfer is converted to an ordinary line. Chamfer 
editing facilities will no longer be available for that line. 

 
Name — Displays the name of the selected chamfer. You can also 
use it to edit the name. 

Next Solution — Displays another chamfer solution for the two lines 
(if one exists). Repeatedly clicking this button will cycle through all 
the solutions. 

Swap Lines — Treats the second line as the first line. 

Untrim Lines — Untrims the two lines back to their original size. 

OK — Saves the edits carried out on the chamfer and closes the 
dialog. 

Cancel — Closes the dialog and discards any edits carried out on the 
chamfer whilst it was displayed. 
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Arcs 
Use the following sections to find out more about  arcs: 

What is an arc? (see page 60) 

Creating an arc (see page 60) 

Editing an arc (see page 70) 

Editing multiple arcs (see page 77) 
 

What is an arc? 
An arc is a sector of a circle. 

 
Two types of arc exist: full (circle) and partial. A full arc has a span 
of 360° with start and end points which coincide and a single key 
point at its centre. A partial arc has three key points: at the start, 
end, and centre positions. 

 

Creating an arc 
1 Select Object > Arc from the menu to display the Arc creation 

submenu. 
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This is equivalent to clicking the Arc button  to display the 
Arc creation toolbar. 

 
2 Select an Arc creation type. The following options are available: 

 Full arc — Click this button to create a full arc (circle). 

 Three points — Click this button to create an arc through 
three points/items. 

 Centre, radius, span — Click this button to create an arc 
through centre, radius, and span. 

 Fillet — Click this button to create a fillet arc. 

 Untrimmed fillet — Click this button to create an untrimmed 
filled arc. 

 

Creating a full arc (circle) 

1 Click the Full Arc  button on the Arc toolbar. 

Notice the shape of the cursor. It appears as a circle in the active 
plane of the current workspace. 

2 Input a position for the centre point of the arc. 
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A circle is created on the screen. 

 
You can edit the circle created. 

You can continue creating more circles while in this creation 
mode. The radius of the next arc is the same as the previous 
one, unless you specify a new radius. You can do this by typing 
the radius command r directly in the graphics window, followed 
by the new value. For example, 

r 50  
3 Press the Enter key. 

 

Creating an arc through three points/items 

1 Click the Three Points  button on the Arc toolbar. 

2 Input the first position to define the start of the arc. 

You may also select an item to define the start tangent of the 
arc. 
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On the screen, a rubber band (in the shape of an arc) is attached 
to the start point  and the cursor . As the cursor moves, the 
rubber band moves. PowerSHAPE is waiting for the next position 
to be entered. 

 
3 Input the second position to define the end of the arc. 

 
You may also select an item to define the end tangent of the arc. 

Notice that the rubber band is fixed to the two ends of the arc. 
As you move the mouse, the rubber band displays the shape of 
the arc as if the cursor is the third position. Also, the radius is 
displayed and updated as you move the mouse. For smaller 
increments of the radius, zoom in, for larger increments, zoom 
out. 

4 Input the third position to define a position on the circumference 
of the arc. 

When you input the third position, the Arc Confirm dialog is 
displayed showing the radius value of the arc. 
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This dialog enables you to enter correct radius values without 
moving the start and end positions of the arc. When you create 
an arc there may be more than one solution.  

5 Click Next Solution to display other solutions. 

When using gridding, there may be occasions where the arc 
radius you require is not snapped to. For example, when working 
with large grid numbers and the increment between the grid 
points is 50, you may find it difficult to enter a radius of 3005. 
This dialog enables you to modify the radius value to 3005. 

6 Change the radius value of the arc, if you wish.  

7 Click OK. 

 If you do not want the Arc Confirm dialog to display every 
time a fitted arc is created, you can switch it off. From the 
Tools menu, select Options... > Object > Arcs to display the 
Arcs page. Deselect the Confirm Radius option. 

 

Creating an arc tangent to a wireframe object 
This is very similar to creating an arc by inputting positions except 
wireframe objects are clicked to define the end tangents of an arc. 

The wireframe objects must lie in the same plane. If they don't lie in 
the same plane, use the Create an untrimmed blend (see page 116) 
option on the curve creation toolbar. 

1 Click the Three Points  button on the Arc toolbar. 

2 Input the first position to define the start of the arc or click a 
wireframe object to define the start tangent of the arc. 

If you move the cursor over a wireframe object and the 
intelligent cursor is switched on, the word Tangent is displayed 
where tangency is defined, otherwise the program assumes a 
start point is being specified. 

If a wireframe object is clicked where tangency is defined, then 
the tangency is worked out as the cursor moves and displays the 
solution as a rubber band. 

3 Input the second position to define the end of the arc or click a 
wireframe object to define the end tangent of the arc. 
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4 If one of the objects is a curve, the arc is drawn and the Arc 
Confirm dialog is displayed showing the radius value of the arc. 

 
5 If none of the objects is a curve, input the third position to define 

a position on the circumference of the arc. 

 
When you input the third position, the Arc Confirm dialog is 
displayed showing the radius value of the arc. 

6 Change the radius value of the arc or the solution, as required. 

7 Click OK  
 

Creating an arc through centre, radius and span 

1 Click the Centre, Radius, Span  button on the Arc toolbar. 

2 Input the first position to define the centre position of the arc. 

On the screen, a circle is displayed to help you input the second 
position. As the cursor moves, the circle changes size and 
displays the radius at that position. 
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3 Input the second position to define the radius of the arc. 

  

 

 Centre position 
 Position of arc radius. 

This also defines the 
start position of the arc. 

A visual aid is displayed to help you input the third position. This 
time as the cursor moves, an arc is displayed. It shows the span 
values from the start position of the arc. 

 
4 Input the third position to define the span of the arc. This also 

defines the end position of the arc. 

The resulting arc is drawn on the screen. 

 
 

Creating a fillet arc 
A fillet arc is an arc created between two objects such that the 
tangents of the arc lie on each object. 

You can also create fillet arcs on composite curves where two lines 
meet. 



 

PowerSHAPE 2015 R2 Reference Help Wireframe modelling • 67  

Fillet arcs between two objects 

1 Create two objects you wish to create the fillet arc between. 

The two objects can be one of the following: two lines; two arcs; 
one arc and one line. 

Suppose we have the following lines. 

 

2 Click  for a trimmed fillet arc or  for an untrimmed fillet 
arc (arc toolbar). 

Notice that the mouse cursor has changed to an arc with a value 
attached and an arrow. The attached value is the default radius 
value. 

 
To change the default radius during the fillet arc creation, type 
the radius command r directly in the graphics window, followed 
by the new value. For example, 

r 50  
Press Enter.  
The new radius value becomes the default radius value and is 
now attached to the cursor. You can also change the default 
radius value using the Options dialog. 
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If you move the cursor over a suitable object, the intelligent 
cursor tells you that you can select this object as the first item. 

 
3 Select one object and then the other. 

For two lines which cross, there are four fillet arc solutions as 
shown below. Therefore, where you select the lines is important. 

 
Make sure you select the lines on the same side of the 
intersection where you want the fillet arc to lie. 

Suppose we want the following fillet arc. 

 
We can select the two lines anywhere as shown below. 
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 Once you select the first line and hover the cursor over the 
second line, a fillet arc is displayed showing you where it will 
be created. You are also told that this line can be selected as 
the second line. 

 Dependencies exist between the two objects and the fillet arc. 
This implies if you edit any of the three objects, the other two 
update accordingly. 

Fillet arcs on composite curves 

Fillet arcs are added to composite curves where two lines meet. 
These fillet arcs become part of the composite curve. 

1 Create a composite curve, for example: 

 

2 Click  (arc toolbar). 

Notice that the cursor has changed to an arc with a value 
attached and an arrow. The attached value is the default radius 
value. 

To change the default radius type the radius command r directly 
in the graphics window, followed by the new value. For example, 

r 50  
Press Enter.  
The new radius value is now attached to the cursor. You can also 
change the default radius value using the Options dialog. 

When you hover the mouse over the composite curve, the 
intelligent cursor shows where the new fillet arcs will lay (see 
figure below). 
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 In the figure below, 20 is the default radius value and 7.5 is 
the gridding distance from the nearest key point on the 
composite curve. 

 
1 Select the composite curve. 

If two lines meet anywhere in the composite curve, a fillet arc is 
added. 

In our example, six fillet arcs are added to our composite curve. 

 
The fillet arcs are edited as part of the composite curve. 

 

Editing an arc 
To edit an arc, use one of the following methods: 

 Select the arc and use the graphical handles to edit it. 

 Select Edit > Modify to display the Arc dialog (see page 72). 

 Double-click the arc to display the Arc dialog. (see page 72) 
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 Right-click the arc and select Modify from the Arc context menu 
to display the Arc dialog (see page 72). The name of the arc and 
the level on which it lies is at the top of the context menu. 

 
 You can also simultaneously edit multiple arcs (see page 77). 

 

Graphically editing arcs 
1 Select the arc to display its graphical handles. 

The graphical handles that appear are shown below. 

 
Handle  moves the start point of the arc and handle  moves 
the end point. In a full arc, handles  and  coincide. 

Handle  moves the centre position of the arc. 

Handle  edits the radius of the arc. 

2 Select the handle of the feature you wish to edit. 

3 Drag the handle to the required value or position. 
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Where a dimension of an arc is edited, for example the radius, it 
is displayed on the screen as you drag the handle. How the 
dimension value increases and decreases depends upon the 
zoom factor. 

In the case of a full arc, when the handle made of handles  
and  is dragged, it splits into two handles. One handle moves 
with the mouse cursor and the other remains stationary. The full 
arc turns into a partial arc. 

If handles  and  on a partial arc are dragged so that they 
coincide, the arc turns into a full arc. 

If you are editing a fillet arc, the results of the edits affect the 
two lines. 

 

Arc dialog 
Use this dialog to edit arcs. If you are editing a fillet arc, the results 
of the edits affect the two lines. 

Change the arc selection whilst the dialog is displayed by clicking a 
different arc. Edit the newly selected arc in the normal way. 

 The Arc dialog is also used to edit multiple arcs (see page 77), 
with a number of slight differences. 

 
Name — Displays the current name of the selected arc. Type in a 
new name if required. 

Radius/diameter — Shows the radius/diameter of the selected arc 
and allows you to edit the value. 

Span Angle — Shows the span of the arc sector in degrees and 
allows you to edit the value. 
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Centre mark type — This option menu does the following to the mark 
of an arc centre: turn it off  or display it as a cross  or a dot . 

 
Full — Converts a partial arc into a full arc. 

Reverse — This reverses the arc so that the start coordinates 
become the end coordinates and the end coordinates the start. 

Workspace — Select the workspace (world or active) in which to edit 
the arc from the drop-down list. 

Centre — This shows the centre coordinates of the arc. To edit the 
values, Enter the X Y Z coordinates or click the Position  button to 
open the Position dialog where you can use position entry tools. 

Through - This allows you to enter a point that the arc must pass 
through. The arc is edited depending on the through point chosen; 
this is shown below. 

1 Select an arc to edit. 

 

2 Click the Position  button and select a point for the arc to 
pass through: 
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The edited arc  passes through the point entered and the 
tangents of the end points remain the same as the original arc . 

 
If you select a through point that falls outside of the end point 
tangencies  of the original arc , the arc is reversed: 

 
The tangents at the end points remain the same for the original arc 
and the edited arc. 

 

Results of editing a fillet arc 
A fillet arc is edited in exactly the same way as other arcs, except 
the results of the edits affect the two objects from which it was 
created. This is because the fillet arc is dependent on the two 
objects. 

This section shows the results of editing a fillet arc. For details on 
editing arcs, see Editing an arc (see page 70). 

Dependencies are relationships created between objects. If you edit 
an object, any other object dependent on it will update 
automatically. Certain edits break dependencies between objects. 
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Editing a fillet arc. 
1 Select a fillet arc. 

 
2 Edit the radius. The two lines either side of it can be trimmed  

or extended  to fit the fillet arc. 
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If you move the position of one of the lines, the arc and the other 
line update too. 

 
If you move the position of one of the end points of the lines, the 
arc and the other line update too. 

 
If you move the start or end positions of the fillet arc, you break the 
dependencies and the lines go back to their original lengths. 
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If you edit the centre of the fillet arc, you break the dependencies 
and the lines go back to their original lengths. 

 
 

Editing multiple arcs 
To edit multiple arcs at the same time: 

1 Select a number of wireframe arcs that you want to edit with one 
of the following methods: 

 Press and hold the Shift key and click the lines. 

 Press and hold the Ctrl key and click the lines. 

 Click and drag the cursor over the lines. 

2 Right-click one of the selected arcs, and select Modify. 

The Arc dialog (see page 72) is displayed. It is similar to that of 
editing a single arc, with the following differences: 

 — The properties that differ between the selected arcs are 
highlighted in pink. 
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 — The range of values is displayed when you hover the cursor 
over a property. 

 

 You can also double-click one of the selected arcs to display 
the Arc dialog. 

3 Edit the properties. 

4 Click OK to apply the changes to the selected arcs and close the 
dialog. 
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Curves 
Use the following sections to find out more about  curves: 

What is a curve? (see page 79) 

Creating a curve (see page 83) 

Editing a curve (see page 166) 
 

What is a curve? 
A curve is a path which joins a series of points. 

 
To create a curve, you input the points and PowerSHAPE 
automatically joins them with a curve. By editing the curve, you can 
then control how the curve enters and leaves a point. 

Generally, curves created within PowerSHAPE are parametric cubic 
curves known as Bezier curves. In this representation, a span of the 
curve is defined by two control points which lie on its tangents at its 
end points. See figure below. C0 is the control point at end point P0 
and C1 at P1. 
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These control points also define the tangent directions (D0 and D1) 
and tangent magnitudes (M0 and M1) at the end points (P0 and P1). 

 
The effect of increasing both the tangent magnitudes 
simultaneously is to give more fullness to the curve as shown 
below. 
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An increase in only one of the magnitudes causes the curve to 
follow the tangent direction at that point for a greater part of its 
length before turning into the other tangent direction. This is shown 
below. 

 
The tangent direction and magnitude before, after or along each 
point in the curve can be set or freed. 

By changing the tangent directions and magnitudes you can get 
considerable control over the shape of the curve, including 
introducing discontinuities at key-points and making spans into 
straight lines, circular or conic arcs. 

A curve can be open or closed (that is the end point of the curve is 
joined to the start point by the last span in the curve). 

 

Tangents at current point 
Each point on a curve has at most two control points: one for the 
curve entering the point and the other for the curve leaving it. On 
the following curve, the control points are shown for point 2. 

 



 

82 • Wireframe modelling PowerSHAPE 2015 R2 Reference Help  

These control points determine the tangent directions and 
magnitudes of the curve through the point. 

Two tangent directions may exist at a point: one before the point 
and the other after it. In the figure, the tangent directions before 
and after are shown for point 2. Notice that the position of the 
tangent direction before is away from its control point and the 
position of the tangent direction after is towards its control point. 

 
You may set the tangent directions before and after the point 
independently or both together. If they are set together, then the 
curve will be smooth with respect to its tangents at that point. The 
figure below shows an example where the tangent direction before 
is equal to the tangent direction after at point 2. 

 
You may introduce discontinuities on the curve by setting the 
tangent directions before and after independently. 

Tangent magnitudes have a more subtle effect than tangent 
directions. Like tangent directions, these may also be set before and 
after each point simultaneously or individually. See What is a curve? 
(see page 79) for further information on how tangent magnitudes 
change the shape of a curve. 
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Creating a curve 
1 From the Object menu, select Curve to display the Curve creation 

options. 
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This is equivalent to clicking the Curve button  to display the 
Curve toolbar and the different curve creation methods. 

 
2 Select a Curve creation type. The following options are available: 

 Bézier (see page 86) — Click this button to create a Bézier 
curve. 

 Snapped Bézier (see page 91) — Click this button to create a 
snapped Bézier curve. 

 Sketch Bézier (see page 93) — Click this button to sketch a 
Bézier curve. 

 Sketch Snapped Bézier (see page 94) — Click this button to 
sketch a snapped Bézier curve. 

 G2 (see page 95) — Click this button to create a G2 curve. 
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 B-spline (see page 100) — Click this button to create a B-
spline curve. 

 Snapped to mesh — Click this button to create a curve that is 
snapped to mesh. (PowerSHAPE Pro only) 

 Mesh Discontinuities — Click this button to create curves at 
discontinuities in mesh. (Delcam Designer and PowerSHAPE Pro) 

 Mesh boundaries (see page 111) — Click this button to 
create curves from mesh boundaries. (Delcam Designer and 
PowerSHAPE Pro) 

 Ellipse (see page 109) — Click this button to create an 
ellipse. 

 Spiral (see page 111) — Click this button to create a spiral. 

 Helix (see page 112) — Click this button to create a helix. 

 Fillet (see page 115) — Click this button to create a fillet. 

 Untrimmed Blend (see page 116) — Click this button to 
create an untrimmed blend. 

 Trimmed Blend (see page 118) — Click this button to create 
a trimmed blend. 

 Composite Curve (see page 104) — Click this button to 
create a composite curve by tracing. 

 Draft curve (see page 121) — Click this button to create a 
Draft curve. 

 Outline curve (see page 123) — Click this button to create an 
Outline curve. 

 Oblique sections on surface (see page 124) — Click this 
button to create a curve from oblique sections on a surface. 

 Surface/solid intersection (see page 129) — Click this button 
to create a curve at a surface or solid intersection. 
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 Projection (see page 131) — Click this button to create a 
curve from a projection. 

 Wrap (see page 134) — Click this button to wrap a curve. 

 Unwrap (see page 157) — Click this button to unwrap a 
curve. 

 Trimline (see page 163) (Toolmaker only). 
 

Creating a Bézier curve 
A curve is first created by entering its key points. You then edit it to 
your requirements using the curve edit facilities. 

1 Click the Bézier  button on the Curve toolbar. 

2 Enter positions for the key points of the curve. 

As you enter key points, a rubber-band curve is displayed 
showing how the curve is forming. 

You can input points on surfaces by pressing and holding the 
Shift key and clicking on them. 

To force the curve to form a straight span between two key 
points, do one of the following when you enter the second of 
these points: 

 Press and hold the Ctrl key while you are clicking the point 

 Type straight and press enter before you enter the position 
using the status bar or the Position dialog 

To inherit the tangency from an existing curve, hold down the 
Shift key when you click a point. The tangency before and after 
of the new point matches that of the position clicked on 
underlying curve. 

3 To finish creating the curve, do one of the following: 

 Click on top of the last key point entered. If the intelligent 
cursor is enabled, an end symbol is displayed  to indicate 
when clicking completes the curve 
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 Click the first key point to create a closed curve. The image on 
the right shows the icon that is displayed over the start point 
of the curve indicating the point of closure . 

 

 Click Select . 

 Choose an option from the Curve toolbar 

The curve is now ready to edit to your requirements. 
 

Editing a Bézier curve 
To edit a Bézier curve: 

1 Select the Bézier curve to automatically display the Curve editing 
toolbar.  

2 Select the Edit as a Bezier curve  option from the Curve Edit 
toolbar. 
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Alternatively, right-click on the Bézier curve to display the Curve 
Edit menu. 

 
The Edit as Bezier curve option is available on the Curve Edit menu 
and the Curve Edit toolbar. Bézier curve graphics handles are 
displayed on the curve to be edited. For further details, see Editing 
a curve (see page 166). 

You can use these options to edit surface curves on a power 
surface. 

 

Creating a curve on a surface 
When you can create a Bézier curve on a surface, a relationship is 
created between the curve point and the surface it lies on. This 
relationship is useful when editing the point and the surface. 

1 Click the Bézier  button on the Curve toolbar. 

2 Input the points of the curve. 

To input a point on a surface patch in shaded mode, click on the 
surface. 
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To input a point on a surface patch in wireframe mode, press and 
hold the Shift key and click on the surface. 

The word In is attached to the cursor when the input point is 
projected onto the surface and the word On at positions on 
surface curves. 

The curve points on the surface have the same tangents as the 
surface points on which they lie. 

In the example below, you can see that the tangency of the 
curve matches the surface. If you want the curve to flow along 
the exact shape of the surface, you may need to put in extra 
points along the curve. 

 
Any curve point, that does not lie on the surface, has no 
relationships. 

3 To finish the curve, do one of the following: 

 Click on top of the last key point entered. If the intelligent 
cursor is enabled, an end symbol is displayed to indicate when 
clicking completes the curve. 

 Click the first key point to create a closed curve. 

 Click the Select  button. 

 Choose an option from the Curve creation menu. 

The curve is now ready to edit to your requirements. 
 

Editing points of a curve on a surface 
When you create a curve point on a surface, a relationship is 
created between the curve point and the surface it lies on. 

When you move or edit the surface, the curve points on the surface 
update too. 
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When you move a point on the surface  

 
the curve changes as the surface changes shape. 

 
When you edit the curve such that its points are within the surface, 
it remains on the surface. The edited curve points have the same 
tangents as the new surface points on which they lie. 

When you drag a curve point  along the surface  

 
it remains on the surface and the tangents through it are updated 
too . 

 
If you drag curve points off the surface, they lose their dependency. 

If you drag a curve point back onto a surface, it gains a new 
dependency. Press and hold the Shift key to place a point inside a 
surface patch. (Ensure the word In is attached to the cursor to 
indicate the point is inside the patch). 
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To delete the dependencies: 

 Select Edit > Surface and Curve Edits > Curve edits > Delete 
dependencies from the menu. 

 Right-click the curve and select Delete dependencies from the 
menu. 

 

Snapped Bézier curve 
You can: 

 Create a Snapped Bézier curve (see page 91) 

 Edit a Snapped Bézier curve (see page 92) 

 Offset a Snapped Bézier curve (see page 93) 
 

Creating a Snapped Bezier curve 
Use this option to sketch curves on a surface, solid, or a shoe last.  

1 Click the Snapped Bezier  button on the Curve toolbar.  

 
2 Click on the model (solid or surface). 

3 Start sketching a curve on the model.  

 Press the Alt key to move the point onto the nearest surface 
edge as shown below. 

 Press Ctrl + Alt to move the point to the surface edge while 
maintaining the straight nature of the curve.  
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4 Click the Select  button to complete the curve. The Snapped 
Bézier curve lies on the surface as shown below. 

 
 

Editing a snapped Bézier curve 
To edit the snapped Bézier curve,  

1 Select the snapped Bézier curve. 

The keypoints on the curve are displayed. 

 
2 Select a keypoint on the curve  
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3 Drag the point to change the shape of the curve. 

 
4 Click away from the model to deselect the curve. 

The Snapped Bezier Curve forms the new shape and remains on 
the surface of the model. 

 
 

Offsetting a snapped Bézier curve 
You can use a keyboard shortcut to offset points on a snapped 
Bézier curve where the points have dependencies on a surface. 

To offset points on a snapped Bézier curve: 

1 Select the points on the curve.  

2 Press Ctrl and  or Ctrl and  to offset the curve points.  
If the curve points have dependencies to a surface, they are 
offset along the surface normal on the curve. 

 

Sketch a Bézier curve 
Use this option to sketch a curve on a surface, solid or shoe last. 
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1 Click the Sketch Bezier  button on the Curve toolbar.  

 
2 Click on the model. 

3 Drag the mouse to start sketching a curve on the model. 

 
4 Release the mouse button to complete the curve. 

You can edit the Bézier curve in the normal way. 
 

Sketch a Snapped Bezier curve 

 This option is available in Footwear mode only. 

Use this option to sketch a curves on a single surface. 
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1 Click the Sketch Snapped Bezier  button on the Curve toolbar. 

 
2 Click on a surface on the model. 

3 Drag the mouse to sketch a curve on the surface. If you attempt 
to sketch outside the selected surface, the curve is snapped to 
the edge, as shown below. 

 
4 Release the mouse button to complete the curve. 

You can edit the Bézier curve in the normal way, but you cannot 
move a point to a position outside the surface. 

 

Creating a G2 curve 
G2 curves are mathematically smoother than Bézier curves. 

1 Click the G2  button on the Curve toolbar. 
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2 Input positions for the points of the curve. 

 
As you enter key points, a rubber-band curve is displayed 
showing how the curve is forming. 

If you want the curvature to be zero at the start point or end 
points, set the Curvature continuous options on the Curve page of 
the Options dialog (which is displayed by choosing Options from 
the Tools menu). 

Zero curvature has a flattening effect on the curve. 

3 To finish curve creation, do one of the following: 

 Click on top of the last key point entered; if the intelligent 
cursor is enabled, the end symbol  is displayed to indicate 
when clicking completes the curve. 

 Click the first key point to create a closed curve 

 Click the Select  button. 

 Choose an option from the Curve toolbar. 
 

Editing a G2 curve 
1 Click on the G2 curve to automatically display the Curve edit 

toolbar. 

2 Select a point on the G2 curve you want to edit. 

You can edit a G2 curve in the following ways: 

 Select the G2 Edit option  from the Edit Tangent Angles flyout 
to display the G2 Curve Fairing dialog (see page 98). 
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 Select the Edit as a g2 curve  option from the 
Bezier/Bspline/G2 flyout. 

 
This is the same as clicking on the G2 curve using the right 
mouse button. The curve-editing options are also displayed on 
the curve context menu and reflect the curve you are editing. 

 
The following editing options are available on the curve popup 
and the curve edit toolbar: 

 Edit as Bezier curve - Select this option to display Bezier curve 
graphics handles on the G2 curve. The G2 curve loses its G2 
editing ability and can be edited only as a Bezier curve. 
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 Edit as a G2 curve - Select this option to display Bezier curve 
graphics handles on the curve for editing. The curve remains a 
G2 curve if you drag the handles. 

You can use these options to edit surface curves on a power 
surface. 

 

G2 Curve Fairing dialog 
Use this dialog to edit the shape of a G2 curve. 

 If you change the shape of the G2 curve using the G2 Curve 
Fairing dialog, it remains a G2 curve. If you use other curve 
editing methods, the curve is likely to lose its G2 curve 
properties. 

 
Point — This is the selected point. You can change this using the 
selector. 

 — To set the tangent direction precisely, click this button to 
display the Direction dialog. Fill in this dialog with new direction 
values and press OK. 

X Y Z — These are the coordinates of the selected point. You can 
use the arrow buttons to increase or decrease the values by 1mm 
(even if the units are imperial). 
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Bias — (Not available for end points on open curves) Changes the 
direction of the curve as it passes through the point. You can also 
use the slider to change the bias value. 

 
Magnitude — (Available only for end points on open curves). Edits 
the tangent magnitude of the point. You can also use the slider to 
scale the magnitude value. 

 
Tension — (Not available for end points on open curves) Edits how 
sharply the curve bends on either side of the point. You can also 
use the slider to change the tension value. 

 
OK — Saves the changes and closes the dialog. 
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Creating a B-spline curve 

1 Click the B-spline  button on the Curve toolbar. 

2 Input positions for the points of the curve. 

 
As you enter key points, a rubber-band curve is displayed 
showing how the curve is forming. 

If you want the curvature to be zero at the start point or end 
points, set the Curvature continuous options on the Curve page of 
the Options dialog (displayed by choosing Options from the Tools 
menu). 

Zero curvature has a flattening effect on the curve. 

3 To finish creating the curve, do one of the following: 

 Click on top of the last key point entered; if the intelligent 
cursor is switched on, the end symbol  is displayed to 
indicate when clicking completes the curve. 

 Click the first key point to create a closed curve. 

 Click the Select  button. When you click this button, the 
edit handles are displayed on the curve. The handles edit the 
shape of the curve.  

 
 Choose an option from the Curve toolbar. 

You can create a B-spline surface from a set of separate B-spline 
curves. 

 

Editing a B-spline curve 
To edit a B-spline curve: 
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1 Click on the B-Spline curve to display the Curve Edit toolbar 
showing the editing options for a B-spline curve :  

 Reverse the curve 

 Select points on a curve 

 Add new point 

 Turn point labels on/off 

 Turn curvature combs on-off 

 Edit as Bezier/B-spline curve/G2 edit 

To access other edit options you must convert the B-spline curve 
to a Bezier curve. 

2 Click the Edit as Bspline  button on the Curve Edit toolbar. 
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Alternatively, right-click on the B-spline curve to display the 
curve-editing menu. 

 
The following editing options are available on the Edit Curve toolbar 
and menu: 

 Edit as Bézier curve — Select this option to display Bézier curve 
graphics handles on the bspline curve. The curve loses its B-
spline editing ability and can be edited only as a Bézier curve. 

 Edit as a G2 curve — Select this option to display Bézier curve 
graphics handles on the curve for editing. The curve remains a 
G2 curve if you drag the handles. 

 Edit as a Bspline curve — Select this option to display the B-spline 
graphics handles for curve editing. 

You can use these options to edit surface curves on a power 
surface. 

 

Edit surface curves on a power surface 
You can use these options to edit surface curves on a power 
surface. 
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Editing the shape of a B-spline curve 
You can edit the shape of a B-spline curve by moving the control 
points. 

1 In selection mode, select the B-spline curve. 

 
The control points are displayed on the curve. Each point has a 
label. 

 
2 Drag a control point to change the shape of the curve. 

In the example below, control point 4 is dragged upwards. 

 
When you drag the control points that are not at the end of the 
curve, the shape of the curve changes and some of its points 
move too. 

 

 The end points always remain fixed, unless you drag them. If 
you drag an end point, only that point moves. 
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You can also move a selected control point using the Position dialog. 

1 On the Edit Curve toolbar, click the Select point  button to 
display the Select Point dialog. 

2 Use the Select Point dialog to select a control point. 

3 Click the Position  button to display the Position dialog. 

4 Use the Position dialog to move the selected control point. 
 

Creating a composite curve by tracing 
A composite curve is a continuous boundary of objects such as 
lines, arcs, curves, and surface edges. You can also create a 
composite curve along the edges of an open, triangulated symbol 
(.stl or .dmt files). 

1 Create the items from which you wish to create a composite 
curve. 

2 Click the Composite  button on the Curve toolbar. 

 
You may set start and end markers before selecting an item to 
indicate where the composite curve starts and ends. 

3 Click one of your items. 
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PowerSHAPE automatically continues to select items from the 
end of the item nearest the click position. 

 
The start of a composite curve is marked with an asterisk. 

4 Use the control panel to define the composite curve from your 
group of items. 

Each button on the control panel is described below: 

 Surface tags — Toggle this button to show or hide surface 
tags. You can show or hide surface tags at any time while 
creating a composite curve. 

If Surface tags is selected, the selected item is automatically 
marked with two parallel lines on its underlying surface . These 
parallel lines are the surface tags. 

 
If you want to change the underlying surface for the first item 

selected, click the Backwards  button or the Rewind  button 
on the Composite curve control panel and then select the surface 
tag on the required surface. 
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When you rewind the composite curve, the item becomes 
unselected and all the possible routes for the composite curve 
are marked with surface tags and arrows. 

 
A surface tag exists for each surface along a particular route. 

If you click a surface tag, the route is selected and becomes 
dependent on the surface for the tag. 

 Composite curves preserve any dependent points when the 
composite curve is created on a curve. 

If you click the Forward  button on the Composite curve control 
panel, the pink item and surface tag are selected. 

 Reset — Click this button to remove all the items from the 
current selection. This enables you to start creating a new 
composite curve. 

 Start marker — Click this button to set the start marker. 

 Rewind — Click this button to rewind the selection to the last 
branch or the start (if no branches exist). 

If you click this button when the first item is selected, the item 
becomes unselected and all the possible routes for the composite 
curve are marked at the start of the item. If you click it again, all 
the markers are removed and you can start creating a new 
composite curve. 

If you click this button after clicking Fast forward, the composite 
curve is returned to its position before the Fast forward was 
performed. 

 Backwards — Click this button to remove the last item in the 
selection. 
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If you click this button when the first item is selected, the item 
becomes unselected and all the possible routes for the composite 
curve are marked at the start of the item. If you click it again, all 
the markers are removed and you can start creating a new 
composite curve. 

 Forwards — Click this button to move forward to the next 
branch point. Choose the next piece of geometry. 

When you have a selection of routes, the one that will be 
selected when you click the Forward button is pink (using the 
default colour scheme). 

You can select an object that is not connected to the current 
selection. If you do this, a dialog is displayed asking if you want 
a straight span or one that preserves the tangents from the end 
of the last object to the new one. 

 Fast forward — This continues selecting items to either the 
end marker or last item. How PowerSHAPE continues selecting 
items is determined by the Direction Strategy set in the Composite 
curves page on the Options dialog. 

 End marker — Click this button to set the end marker. 

 Reverse — Click this button add or remove objects from the 
other end of the composite curve. 

 Save — Click this button to save the selection as a composite 
curve. Alternatively, you can right-click on the curve to save it. 

 Branch Point Direction — This allows you to choose which 
direction to go when in Fast Forward mode. 

 Options — This raises the Curve page of the Options dialog. 

 Eject — This removes the Create Composite Curve control 
panel from the screen. 

1 When you have created your composite curve, either continue 

creating composite curves or click Select  or Eject  to 
remove the control panel. Alternatively, right-click to close the 
Composite curve toolbar. 

 You can convert a composite curve to its individual objects 
using the Edit > Convert > to wireframe command. 
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Using start and end markers 
When creating composite curves, start and end markers enable you 
to restrict the region in which you select items. They also enable 
you to select a portion of length of a single item. Once you add the 
markers, begin selecting the composite curve close to the start 
marker. 

To add a start marker: 
1 From the Create Composite Curve control panel, select the Start 

marker  button. 

2 Input a position to add the start marker. A start marker is added 
to your model. This is only a visual aid which is displayed whilst 
the Create Composite Curve control panel is displayed. 

To add an end marker: 
1 From the Create Composite Curve control panel, select the End 

marker  button. 

2 Input a position to add the end marker. An end marker is added 
to your model. This is only a visual aid which is displayed whilse 
the Create Composite Curve control panel is displayed. 

To remove a marker: 
1 From the Create Composite Curve control panel, select the button 

of the marker you want to remove, that is, either a Start or End 
marker. 

2 Click on the marker you wish to remove. 

To move a marker: 
1 From the Create Composite Curve control panel, select the button 

of the marker you wish to move. 

Input the new position. 

You may have only one marker of each type displayed at any one 
time. 

 

Other methods for creating composite curves 
You can also create composite curves using the following methods: 

 In selection mode, press and hold the Alt key and click on an 
object. 
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This automatically selects all the other objects which are joined 
to the selected object to form a composite curve. This mode 
automatically follows connected curves (of whatever type — line, 
arc, curve, visible trim boundary, lateral, longitudinal) and 
(silently) makes a single composite-curve from them. 

You are provided with only one option which behaves like the 
Fast forward option in the curve creation mode. This provides a 
quick method for creating composite curves. 

 There is a command to convert selected wireframe items into a 
composite curve. This is equivalent to using Alt +click. To use it, 
select the wireframe and in the command window type: 

"convert_to_compcurve" 

 Select wireframe objects and, from the Edit menu, select Convert 
followed by Wireframe to composite curve. 

This creates composite curves from all the selected objects, 
attempting to connect adjoining pieces. 

 

Setting composite curves options 
To change the composite curve settings: 

1 Select Tools > Options from the menu to display the Options 
dialog. 

2 Select the Object > Composite curves page. 

3 Use the Composite curve page to set the options. 

4 Click OK. 
 

Creating an ellipse 

1 Click the Ellipse  button on the Curves toolbar. 

2 Position the cursor and click to enter the point of origin for the 
ellipse. 

3 Use the Ellipse dialog (see page 110) to specify the dimensions 
for the ellipse curve. 

4 If necessary, use the Curve editing toolbar to make changes to 
the wireframe curve. 
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Ellipse dialog 
Use this dialog to specify the dimensions of the wireframe ellipse. 

 
1 Enter the Major axis length of the ellipse. Alternatively, use the 

drag the handles to increase or decrease the size. The value is 
displayed alongside the cursor as the handles are dragged. The 
dialog is updated with the new value. 

2 Enter the Minor axis length of the ellipse. Alternatively, use the 
drag the handles to increase or decrease the size. The value is 
displayed alongside the cursor as the handles are dragged. The 
dialog is updated with the new value. 

 
3 Enter the number of Points per quadrant to indicate the number of 

points in each section of the ellipse. Increasing the number of 
points per quadrant increases the accuracy of the curve that is 
produced. 

4 Click OK to create the ellipse. 

5 If required, create another ellipse. Alternatively click the Select 

 button to end ellipse creation; the points on the ellipse are 
then displayed. 

 
 

Creating a curve snapped to a mesh 
Functionality to create a curve snapped to a mesh is available only 
with a PowerSHAPE Pro licence.  

For further details see Create curve snapped to mesh. 
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Creating a curve at discontinuities in mesh 
This functionality is only available with a Delcam Designer or 
PowerSHAPE Pro licence. 

For further details see Creating curve at discontinuities in mesh. 
 

Creating curves from mesh boundaries 
This functionality is only available with a Delcam Designer or 
PowerSHAPE Pro licence. 

For further details see Create curves from mesh boundaries. 
 

Creating a spiral 

1 Click the Spiral  button on the Curves toolbar. 

2 Enter the point of origin for the spiral. 

3 Use the Spiral dialog (see page 111) to specify the dimensions 
for the spiral curve. 

4 If necessary, use the Curve Edit toolbar to make changes to the 
curve. 

 

Spiral dialog 
Use this dialog to specify the dimensions of the Spiral. 

 
1 Enter the Start radius. 

2 Enter the End radius. Alternatively, use the drag the handles to 
increase or decrease the size. The value is displayed alongside 
the cursor as the handles are dragged. The dialog is updated 
with the new value. 

3 Enter the number of Turns to be created on the spiral. 
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4 Enter the number of Points in each turn to indicate the number of 
points to be created on each turn of the spiral. Increasing the 
number of points per turn increases the accuracy of the curve 
that is produced. 

 
5 Click OK to create the spiral. 

6 If required, create another spiral. Alternatively click the Select 

 button to end spiral creation; the points on the spiral are 
then displayed. 

 
 

Creating a helix 

1 Click the Helix  button on the Curves toolbar. 

2 Enter the point of origin for the helix. 

3 Use the Helix dialog (see page 113) to specify the dimensions for 
the helix curve. 

4 Use the Curve Edit toolbar to make changes to the wireframe 
curve. 
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Helix dialog 
Use this dialog to specify the dimensions for the helix. 

 
Height — Enter the overall vertical height of the helix. This is 
measured from the point of origin. 

Whilse the Helix dialog is displayed, you can also change the 
height of the helix by dynamically dragging the arrow handle at 
the top of the helix. 

 

 The Height, Pitch, and number of Turns are related. If you 
change one value another value must also change in order 
to keep the definition of the helix consistent. 

Pitch — Enter the vertical distance between consecutive turns. 

Turns — Enter the number of turns in the helix. 
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 Lock/Unlock — Lock or unlock the Height, Pitch, and number of 
Turns for the helix. When a dimension is locked it does not change 
when you change another dimension. For example, if the height is 
locked and you change the pitch, the number of turns changes to 
keep the definition consistent. 

In the example below, the height is 100, the pitch is 16.6, and 
there are 6 turns. 

 
The example below shows the same helix with the height locked 
and the pitch increased to 30. The number of turns has 
decreased to maintain consistency. 

 
Points in each turn — Specify the number of points per turn. 
Increasing the number of points per turn increases the accuracy of 
the curve that is produced. 

Top Radius — Enter the radius for the top of the helix. 
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Whilse the Helix dialog is displayed, you can change the top 
radius of the helix by dynamically dragging the arrow handle at 
the top of the helix. 

 
Base Radius — Enter radius for the bottom of the helix. 

Whilst the Helix dialog is displayed, you can change the base 
radius of the helix by dynamically dragging the arrow handle at 
the bottom of the helix. 

 
Constant Radii — If selected (default), the base and top radii remain 
equal.  

Flip Direction — Select this option to flip the direction of the helix 
between clockwise and anti-clockwise. 

Close Top — Select this option to create a closed 360  loop at a 
constant height around the top of the helix. 

Close Base — Select this option to create a closed 360  loop at a 
constant height around the base of the helix. 

 The axis of the helix aligns with the normal of the active 
workplane. 

 

Creating a fillet 
This creates a fillet between two intersecting curves where you can 
specify the fillet radius. 
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1 Select the intersecting curves, or the Intersection point. 

 

2 Click the Fillet  button on the Curve toolbar. 

The Fillet Confirm dialog is displayed, where you can enter a 
different radius. 

 
The fillet is created on the intersecting curves. 

 
3 Click Next solution to display up to four possible fillet solutions. 

4 Click OK or click in the graphics area to accept the displayed 
solution. 

 For further details, see Curve Options (Menus and Toolbars). 
 

Creating an Untrimmed Blend 
This option is generally used when you want to create a fitted, 
circular curve between non-planar wireframe objects. 

1 Click the Untrimmed Blend  button on the Curve toolbar. 
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To create a fillet between the following lines. 

 
2 Input the first position to define the start of the curve or click a 

wireframe object to define the start tangent of the curve. 

If the cursor is moved over a wireframe object and the intelligent 
cursor is switched on, the word 'Tangent' is displayed where 
tangency is defined, otherwise (for example, if 'End' is displayed) 
the program assumes a start point is being specified. 

If a wireframe object is clicked where tangency is defined, then 
the program works out the tangency as the mouse cursor moves 
and displays the solution as a rubber band. 

 
3 Input the second position to define the end of the curve or click a 

wireframe object to define the end tangent of the curve. 
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The new fillet curve is created. It is a two point Bezier curve. 

 
The curve approximates to an arc when projected onto the 
principal plane. 

 

Creating a Trimmed Blend 
This option can be used to 

 Create a fitted, circular curve between two non-planar wireframe 
objects and trim the unwanted parts. 

 Create a fillet between two discontinuous corners of a single 
curve 

The items that can be filleted with this option are: lines, arcs, 
curves and composite curves. There are 8 trim solutions. 

1 Click the Trimmed Blend  button on the Curve toolbar. 

2 Click the first position to define the start tangent of the curve. 

3 Click the second position to define the end tangent of the curve. 
The new fillet curve is created and the objects are trimmed. It is 
a two point Bézier curve. 

4 Use the Trim Solution dialog to display each of 8 trimmed fillet 
solutions. 

 

Curve between non-planar wireframe objects 

1 Click the Trimmed Blend  button. 

2 Click the first position to define the start tangent of the curve . 
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If the cursor is moved over a wireframe object and the intelligent 
cursor is switched on, the word 'Tangent' is displayed where 
tangency is defined, otherwise PowerSHAPE assumes a start 
point is being specified. 

 
3 Click the second position to define the end tangent of the curve 

. 

 

 
The new fillet curve is created and the objects are trimmed. It is 
a two point Bezier curve. 

 
4 Use the Trim Solution dialog (see page 121) to display each of 8 

trimmed fillet solutions. 

 For further details, see Curve Options (Menus and Toolbars)..  
 

Fillet between two discontinuous corners of a single curve 
The Trimmed Blend option on the Curve creation menu can be used 
to create a fillet between two discontinuous corners of a single 
curve. 
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1 Click the Trimmed Blend  button on the Curve toolbar. 

2 Click on the first position to define the start tangent of the curve. 

If the cursor is moved over a wireframe object and the intelligent 
cursor is switched on, the word 'Tangent' is displayed where 
tangency is defined, otherwise (for example, if 'End' is displayed) 
the program assumes a start point is being specified. 

 
3 Click the second position to define the end tangent of the curve 

where the blend needs to be defined. 
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4 The new fillet curve is created and the objects are trimmed. It is 
a two point Bezier curve. 

 

  If the Prompt for Trimming Solutions option is selected on the 
Curves page of the Options dialog, the Trim Solution dialog 
(see page 121) is displayed where you can display each of 8 
trimmed fillet solutions. 

 
 

Trim Solution dialog 
This dialog is used to display the next trimming solution when using 

the Trimmed Blend  button (curves toolbar) on a wireframe 
object. 

 
Next Solution — Click to display each of 8 trimmed fillet solutions. 

OK — Click to accept the solution displayed. 
 

Creating a draft curve 
You can create draft curves from surfaces, solids, and components. 
A draft curve is used to create a draft surface. 
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The points of the draft curve are determined along a surface. The 
points are taken as positions on the surface where the tangent 
makes the draft angle with the axis normal to the principal plane. 

 
These points are used to define the draft curve. 

Draft curves are similarly created on solids and components. 
To create draft curves, 
1 Select the surfaces, solids, and components. 

2 Click the Draft  button on the Curve toolbar. 

3 Use the Draft dialog to define the draft curve. 

 
Draft Angle — Input the draft angle. 

Create as composite curves — Select this option to create the 
draft curves as composite curves. Deselectt it to create them as 
wireframe curves. The colour of the wireframe curves is the 
same as the underlying surfaces. 

4 Click OK to generate the draft curves. 

 Creating a draft curve is not available in Delcam Designer. 
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Creating an outline curve 
Create a composite curve outline around the selected surfaces, 
solids and components. 

1 Select the objects that will be used to create the outline curve. 

 

2 Click the Outline  button on the Curve toolbar to display the 
Create Outline Curves dialog. 

 
The projection plane is displayed aligned normal to the principal 
plane.  

 

3 Use  to change the principal plane. 
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4 Click OK to create outline curves for the selected objects.  

 
If Project curve is selected (default), the outline curves are drawn 
on the projection plane, as shown.  

If Project curve is deselected, the outline curves are created in 
the same position as the objects. Blank the objects to see the 
outline curves. 

 

Creating curves from oblique sections 
1 Create a workplane. 

 
The principal plane of the active workplane is used to define the 
plane which intersects the surfaces and solids to create the 
oblique curve. 

If no workplane is active, then the principal plane of the world 
workspace is used. 

2 Position the workplane so that its principal plane is at the angle 
you wish to create the oblique curve. 
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3 Select the surfaces, solids, meshes and components. 

4 Click the Oblique  button on the Curve toolbar. 

5 Use the Oblique dialog (see page 125) to define your oblique 
curve. 

 

Oblique dialog 
Use this dialog to create curves from oblique sections on surfaces, 
solids, meshes, and components. 

 
A plane is displayed to show where the oblique curves cut the 
objects. 

 

Method 
Select one of the following methods to create the curve: 

 Select Distance and set the distance along the principal axis from 
the principal plane where you want the oblique curves to cut the 
objects. If necessary, change the principal axis using the 
principal plane buttons  on the status bar.  



 

126 • Wireframe modelling PowerSHAPE 2015 R2 Reference Help  

When you enter a distance, the plane moves to the new position 
of the oblique curve. Enter a value of 20. The plane moves to 
reflect the change. 

 
 Select Selected Items to automatically create a Number of sections 

through the selection.  

 Select Cursor Pick to set the required position for the creation of 
the oblique sections by selecting a point. The oblique sections are 
created using the selected point as shown in the model below: 

 
 Select Curve to create oblique curves normal to a 3D drive-curve, 

at a given distance or with a specified number of sections: 

a Select the curve to be used as a drive curve . 

b Adjust the settings on the other options as required. The 
model below shows ten oblique curves. 
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c Click Preview to view the curves. 

 

Section settings 
Use the following options to create one or more oblique curves from 
the plane, along the principal axis. 

 Enter the Number of oblique curves. 

 
 Enter the Step to set the distance between each oblique curve. If 

Selected items is selected, Step cannot be modified. 

 
 Set the distance the oblique curves are Offset from the objects. 

The offset is along the plane, on the same side as the surface 
normal at each point. If the offset is zero, the new curve is 
dependent on the underlying surface.  
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An offset value of 5 was used in the example below. 

 
 Select Trim length to trim oblique curves to the specified length. 

The oblique curves on the following model have been trimmed to 
10. 

 
 Select Display length to display the length labels as shown below: 

 
 Select Create as composite curves to create the oblique curves as 

composite curves. Deselect this option to create the oblique 
curves as wireframe curves. 

 The colour of the wireframe curves is the same as the 
underlying objects, whereas composite curves use their 
default colour. 

 Select Arc fitting to automatically apply Arc fitting (see page 205) 
to any curves created using the dialog. You can also click the Arc 
fitting options  button to open the Arc Fitting dialog (see page 
206). 

 Click Apply to generate the oblique curves and continue adding 
further oblique curves to the objects. 
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 Click OK to accept the changes and close the dialog. 
 

Surface, solid, or mesh intersection 
You can create composite curves at the intersection of surfaces, 
solids, meshes and components. You can also create composite 
curves where the objects would intersect, if offset by a specified 
distance. 

1 Select the objects that you want to create the curve of 
intersection from. 

2 Click the Intersection  button on the Curve toolbar. 

3 Use the Intersection dialog (see page 129) to create the curve. 

If a component is a sub-assembly, the objects in the sub-assembly 
are not intersected with each other, unless you activate the sub-
assembly and perform the intersection on that. 

 

Intersection dialog 
Use this dialog to create curves from intersecting meshes, surfaces, 
solids, and components. 

 
Offset thickness — Enter an offset value. Initially this is set to zero; 
however the dialog remembers the last value entered. 

Suppose we have the following intersecting surfaces on the screen. 
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If you enter an Offset thickness of 0 and click OK, composite curves 
are created at the intersection of the objects . 

 
However if you enter a non-zero value as the Offset thickness, the 
surface normals of the selected surfaces are shown . 

 
The offset is in the direction of the surface normal at each point 
where the objects intersect. You can click on the surface normals to 
change their direction. This changes the way that the objects 
intersect when offset. 
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When you click OK, the program calculates where the surfaces 
intersect if offset by the thickness and creates curves at the 
intersection . 

 

 
Selection — Enables you to create composite curves at the 
intersection of two groups of objects. 

Select the Primary option and then select one group of objects. 

Select the Secondary option and then select the other group. 

If objects are selected before the dialog is displayed, they are 
automatically put in the primary group. 

If there are no objects in the secondary group, the new curves are 
created at the intersections of the objects in the primary group. 

OK — This generates composite curves at the points where the 
objects would intersect depending on the value of Offset thickness 
and removes the dialog from the screen. 

Cancel — This removes the dialog from the screen without 
generating any composite curves. 

 

Curve projection 
You can create composite curves by projecting multiple wireframe 
objects or highlighted edges onto: 

 surfaces, solids, meshes and components. 
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 principal plane. 

To create the composite curves, 

1 Select the wireframe objects or highlighted edges and the 
objects to project onto. If no surfaces, solids, meshes or 
components are selected, the wireframe objects or highlighted 
edges are projected onto the principal plane. 

 

2 Click the Projection  button on the Curve toolbar. 

 
3 Use the dialog to choose one of the following Projection Types 

and create the curve: 
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Along principal axis — This projects the wireframe along the 
principal axis onto the selected objects. 

 

 
If no surfaces, solids, meshes, or components are selected, the 
wireframe objects are projected onto the principal plane. 

Through item — (Valid only when surfaces, solids, meshes, or 
components are selected.) This projects the wireframe through 
the objects along the principal axis. A new curve is created on 
each surface that the wireframe touches. 

Along item's normal — (Valid only when surfaces, solids, meshes, 
or components are selected.) This projects the wireframe onto 
the selected objects along the surface normals. 

4 Click OK. Composite curves are created where the wireframe 
objects are projected. 

The new composite curves are dependent on the underlying 
surfaces if projected onto objects. 

 



 

134 • Wireframe modelling PowerSHAPE 2015 R2 Reference Help  

Wrapping wireframe onto surfaces/solids 

1 Click the Wrap  button on the Curve toolbar to start the Wrap 
Wizard. 

 
2 Ensure your wireframe objects are orientated correctly in the XY 

plane. 

During wrapping, the wireframe objects are converted to 2D by 
projecting them onto the XY plane of the world space or the 
objects' group workplane (if one exists). 

If your wireframe geometry isn't correctly orientated in the XY 
plane, follow the steps below: 

a Create a grouped workplane. 

b Align the workplane so that its Z axis is normal to the plane of 
the geometry. 

c Select the wireframe objects. 

d Select Edit > Add to active workplane group to add the 
wireframe objects to the workplane's group. 

e Deactivate the grouped workplane. 

3 Create a workplane, if necessary, to position the wireframe on 
the solid and surface objects. 

The wireframe is centred on the workplane origin and its Y axis is 
aligned with the workplane's Y axis (if you decide to use the 
workplane option). 

4 Select View > Shaded to shade your model. 

5 Select all the wireframe, solid, and surface objects that you want 
to use. 

The Wrap Wizard is also available on the Surface toolbar. 
 

Wrapping Wireframe using the Wrap Wizard 

1 Click the Wrap  button on the Curve toolbar to start the Wrap 
Wizard. 
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2 Use the Wrap Wizard to create and edit the wrapped curves. The 
Target Selection (see page 135) page of the Wrap Wizard is 
displayed. 

 

Wrap Wizard - Target Selection (wireframe) 
Use this page to select the target surfaces and/or solids for wrap. 

 
Targets Selected — Select the target surface for the wrap and The 
cross  icon changes to a tick  icon. 

Set target type to curve for extrusion — This option is used for 
wrapping curves more easily in shoe design where you have a curve 
representing a cross section of the shoe sole instead of an existing 
sole surface. Any type of curve can be used as long as it is a single, 
planar curve. 

Select this option on the dialog then select the cross section curve 
as the target. An extruded surface is created automatically from the 
cross section curve which is then used as the target for wrapping. 

Test Wrap — Click this button to create a test wrap for the selected 
wireframe and target object to see the viability of the results before 
proceeding through the Wrap Wizard. 

Next — Click this button to move to the Wrapper Selection (see 
page 136) page of the Wrap Wizard. 
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Wrap Wizard - Wrapper Selection (wireframe) 
This page displays the selected wireframe to be wrapped onto the 
target surface or solid. 

 
The example below shows the Reference workplane. 

 
Use settings from previous unwrap — This is selected automatically if 
wireframe has been previously unwrapped. For further details, see 
What is Wrapping? (Surface modelling manual).. 

Wrappers selected — Select the wireframe to be wrapped onto the 
target surface. The cross  icon changes to a tick  icon.. 

Next — The Datum Workplane (see page 137) page of the Wrap 
Wizard is displayed. 
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Wrap Wizard - Datum WorkPlane (wireframe) 
Use this page to select the workplane for the selected wireframe. 

 
Select one of the following workplanes: 

Reference — The wireframe is wrapped onto the target object in 
a position relative to the reference workplane. 

World — The wireframe is wrapped onto the target object in a 
position relative to the world workplane. 

The workplane is displayed on the selected wireframe. The example 
below shows the Reference Workplane. 

 
Reset — Click this button to reset the reference workplane to align 
with the workplane of the selection. 

Next — The Wrap Method (see page 138) page of the Wrap Wizard 
is displayed. 

Back — Reverses the Wrap Wizard. 
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Wrap Wizard - Wrap Method (wireframe) 
Use this page to select the method to apply the wrappers to target 
objects. 

 
The target object changes colour. 

 
Chord — Select this method to wrap wireframe triangles onto the 
target object minimising distortion. 

You define how the Chord wrapper is applied to the target object on 
the Chord Length Wrap Map Creation (see page 140) page of the 
Wrap Wizard. 

Plane — Select this method to project the wireframe as a plane onto 
the objects. 

To position the wireframe correctly, view the objects on the screen 
so that you are looking directly at the area where the wireframe 
lies. Then select the Plane option. 

If the option was already selected before you adjusted the position 
of the objects, select it again after adjusting the position. 

 If a single primitive plane is selected, the wireframe is fitted 
onto it, regardless of its orientation. 
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Cylinder — This projects the wireframe as a cylinder onto the 
objects. 

The wireframe is wrapped onto the objects along the vertical axis of 
the screen. It is then projected on the objects from the bounding 
cylinder around them. 

Before selecting this option, make sure the objects are viewed such 
that the vertical axis of where you want to put the wrapped curves 
is aligned with the vertical axis of the screen. 

 If a single primitive cylinder is selected, the wireframe is 
fitted onto it, regardless of its orientation. 

The example below uses the cylindrical projection and the active 
workplane lies on the surface of the bottle. 

 
The wireframe is wrapped around the bottle. It is also centred on 
the workplane origin and its Y axis is aligned with the 
workplane's Y axis. 

UV — This projects the wireframe using the parameter space of 
each object. 

Cone — This option is selected when creating a 360 degree conical 
wrap and is greyed out when other wrap methods are in progress. 
For further details, see Creating a 360 degree conical wrap (see 
page 143) 

Next — Different pages of the wizard are displayed depending on 
which method is selected: 
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Plane, Cylinder, or UV methods — The Wrapper Layout (see page 
141) page of the Wrap Wizard is displayed. 

Chord method — The Chord Length Wrap Map Creation (see page 
140) page of the Wrap Wizard is displayed. 

 

Wrap Wizard - Chord Length Wrap Map Creation (wireframe) 
Use this page to define how the Chord wrapper is applied to the 
target object. 

 The wrap map is a 2D coordinate system for a triangulated 
surface. It is displayed as a black and white chequerboard 
effect on the target object. 

 
Minimize Distortion — This option enables you to select where to 
minimize the distortion caused by the wrapping process. Select one 
of the following: 
 Radially 
 Along workplane X axis 
 Along workplane Y axis 
 Globally 

For further detail on these options, see Wrap Wizard - Chord Length 
Map Creation (Surface Modelling). 

Wrap Precision — Drag the slider to adjust the precision of the wrap 
map to reduce distortion if necessary. Higher gives the best wrap 
quality but the wrap map takes longer to create. The default 
position is Normal. 
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Wrap Stiffness — Move the slider to adjust the wrapping angle. 
Maximum stiffness reduces wrapping angles and preserves large 
map areas. Minimum stiffness increases wrapping angle of the wrap 
map for greater curvature. The default position is Normal. 

Preview — Click this button to display the wrap map on the target 
surface or solid to visualise the results of the wrap. This is 
represented by a chequerboard effect in order to show any 
distortions. 

 
Next — The Wrapper Layout (see page 141) page of the Wrap Wizard 
is displayed. 

 

Wrap Wizard - Wrapper Layout (wireframe) 
Use this page to adjust the position of the wireframe using the 
sliders. 

 
The wireframe wrapper is projected onto the target surface or solid. 
The projected image changes as you move the sliders. The values 
are proportions of the projection space. 
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  To finely adjust the sliders, use the arrow keys on the 
keyboard or the mouse wheel. 

 
True size — Select this option to maintainthe aspect ratio and size of 
the wireframe. 
Mirror Width: 

 
Mirror Height: 

 
Width Offset — Offsets the wireframe along the width. 

Size — This scales the wireframe in all directions. 

 
Height Offset — Offsets the wireframe along the height. 

Aspect — This scales only the height of the wireframe. 

Rotation — Use the slider to rotate the wireframe or enter the angle 
of rotation. 
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Next — Displays the Wrap Wire (see page 143) page of the Wrap 
Wizard. 

 

Wrap Wizard - Wrap Wire 
Use this page to Preview or Finish the wrap. 

 
Preview — Displays the results of the wrap using the options 
selected.  

Back — Reverses the Wrap Wizard to allow you to select other 
options. 

Finish — Completes the Wrap Wizard and creates the final wrap. 

The selected wireframe object is wrapped onto the target surface or 
solid. 

 
 

Creating a 360 degree conical wrap 
There are three stages to creating a 360 degree wrap on a cone 
shaped object. 

1 Conical wrapping can only be done as a rewrap, so it first has to 
be unwrapped. Unwrapping flattens the shape so the additional 
relief can be added. In order to unwrap the cone you first need 
to create a Cone Primitive to guide the conical projection of the 
unwrap. 

2 Create the pattern on the unwrapped curves. 
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3 Rewrap the additional detail onto the model. 

The cone shaped top on the bottle shown below is an example of 
where 360 degree conical wrapping can be used. 

  360 degree conical wrapping is not available for solid wrap 
features or for wrapping wireframes. 

 
 

Unwrapping the cone 
1 The conical projection in this type of unwrapping is guided by a 

primitive cone surface that you have to create first. You need to 
create a Cone Primitive that closely matches the conical shape of 
the object you want to unwrap. 

The image below shows a cone primitive positioned closely to the 
original cone surface of the bottle example. 

 
2 Select both the original cone and the cone primitive. 

3 Click the Unwrap  button on the Curve toolbar. 

4 Click Next.  
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The Cone wrap method option is selected automatically. 

 
A chequerboard visual effect is displayed on the target object to 
show the effect of the Cone wrap method. 

 
5 Click Next. The Curve Selection page of the Unwrap Wizard is 

displayed. 

6 Select the Patch Boundaries option. This displays useful 
guidelines in the unwrapped curves. 
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7 Click Next. The Unwrap Curves page is displayed. 

 
8 Click Preview…. 

 
9 Click Finish. The curves are unwrapped and the guidelines are 

displayed 
 

Creating the pattern on the unwrapped cone 
1 Create a pattern in the unwrapped curves. 

In the example below, the pear pattern has been previously 
created and imported into position using the guidelines of the 
unwrapped curves. 

 
2 The pattern now needs to be exported as a picture file to be 

created into 3D reliefs in ArtCAM. The 3D reliefs are then 
imported back into PowerSHAPE. 
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The example below shows the imported 3D reliefs. 

 
 

Rewrapping the pattern onto the cone 
To rewrap the 3D relief pattern onto the cone: 

1 Click Wrap Triangles  on the Surface toolbar. 

The Target Selection page of the Rewrap Wizard is displayed. 

2 Select the cone and click Next. 
The Wrapper Selection page is displayed. 

3 Select the pear pattern on the unwrapped curves. The pattern is 
displayed in the dialog. 

 
4 Ensure the Use settings from previous unwrap option is selected. 

5 Click Next. The pattern is projected onto the cone surface. 
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The Wrap Triangles page is displayed. 

 
6 Click Finish 

 
The bottle example shows the effect of this 360 degree conical 
wrap. 

 
 

Creating a 360 degree cylindrical wrap 
1 Select the cylindrical surface you want to wrap on to. 
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The cylindrical shape of the bottle shown below is an example of 
where 360 degree cylindrical wrapping can be used. 

 

2 click Wrap Triangles  on the Surface toolbar. The Target 
Selection page of the Wrap Wizard is displayed. 

3 Click Next. The Wrapper Selection page is displayed. 

4 Select the DMT File option. 

5 In the Load DMT File dialog, select the dmt file you want to use 
for the wrap. The image is displayed in the dialog. 

 
6 Click Next. 
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7 Select the Cylinder wrap method. 

 
A chequerboard visual effect is displayed on the target object to 
show the effect of the Cylinder wrap method. 

 
8 Click Next. 
9 The wrap is displayed on the cylinder. 

 
The Wrapper Layout page is displayed where you adjust the 
layout settings for the wrap on the object. 
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 To achieve the best results from a 360 degree cylindrical 
wrap, it is advisable to adjust the Size so the edges of the 
wrap overlap slightly where they meet. 

 
In this bottle example the True Size option is deselected and the 
Size is adjusted to 1.005. 

1 Click Next. 
2 Click Finish.  

The bottle example shows the effect of this 360 degree 
cylindrical wrap. 

 
 

Creating a shoe sole wrap 

1 Click Curve Wrapping  on the Curve menu. 

The Target Selection page of the Wrap Wizard is displayed. 
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2 Select the Set target type to curve for extrusion option. 

 
3 The example image below shows a shoe sole outline and a curve 

representing a cross section of the shoe sole. This cross section 
curve is extruded automatically to create the shoe sole that the 
sole outline can be wrapped onto. 

4 Select the cross section curve. 

 
When the target is selected  next to Targets Selected changes 
to . 
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5 Click Next. 

 
6 Select the sole outline to wrap onto the extruded cross section 

curve. 

 
When the wrapper is selected  next to Wrappers Selected 
changes to . 

7 Click Next. 
An extruded surface is created from the cross section curve. 

 
The Datum Workplane page of the wrap wizard is displayed. 
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8 Select the datum workplane you want to use for the wrappers. 
The Reference workplane is selected automatically in this 
example. 

 
If the wrapper (outline) curve intersects the extrusion curve, the 
datum workplane is positioned at the intersection, as shown in 
the example model. If the two curves do not intersect, the datum 
workplane is positioned in the default position at the centre of 
the wrapper. The workplane can be repositioned and edited if 
required. 

9 Click Next. The Wrap Method page is displayed. 

 
The Chord length option is selected by default. This option is 
recommended for best results when wrapping onto shoe soles. 
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10 Click Next. The Chord-Length Wrap Map Creation page is 
displayed. 

 
11 Click Preview. The wrap map is created. 

 
A chequerboard visual effect is displayed on the target object to 
show the effect of the Chord Length wrap method. 
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12 Click Next. The Wrapper Layout page is displayed where you may 
adjust the layout settings for the wrap on the target. 

 
13 Click Next. The Apply wireframe wrappers page is displayed. 

 
14 Click Finish to create the wrapped curve. 
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Curve Unwrapping 
Curve Unwrapping uses the Unwrap Wizard to unwrap curves from 
surfaces and solids. It unwraps, or flattens, a shape so that 
additional wireframe items or symbols can be added. The modified 
shape can then be wrapped back on to the target object. For further 
details, see Wrapping (Surface modelling manual). 

You can unwrap the following: 

 Dependent curves 

 Trim curves 

 Patch boundaries 

 To wrap the shape back on to the target surface, click the 
Wrap Triangles option on the Surface toolbar. This starts the 
Wrap Wizard that is automatically renamed Rewrap Wizard as it 
identifies a previously unwrapped surface. 

 

Using the Unwrap Wizard 

1 Click the Unwrap  button on the Curve toolbar to start the 
Unwrap Wizard. 

2 Select the curves you want to unwrap. 

The Target Selection page of the Unwrap Wizard is displayed. 
 

Unwrap Wizard - Target Selection 
Use this page to select the target object that you want to unwrap. 

 
Targets selected — Select the item to unwrap. The cross  icon 
changes to a tick  icon.. 
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Test Wrap — This displays the Chord Length Wrap Map Creation page 
of the Wizard. It enables you to preview the results of a Chord-
Length wrap on the targets before loading the triangle files. 

Next — Click this button to display the Unwrap Method page of the 
Unwrap Wizard. 

 

Unwrap Wizard - Unwrap Method 
Use this page to select the method for unwrapping the target 
object. 

 
Method — Choose one of the following unwrap methods: 

Chord — This method unwraps curves from the target object 
minimising distortion. You define how the target is unwrapped on 
the Chord Length Wrap Map Creation page of the Unwrap Wizard. 
For further details, see Unwrap Wizard > Chord Length Wrap 
Map Creation (see page 159). 

Plane — This projects the unwrapped curves onto a plane from 
the target object. You can modify the plane in the graphics 
window. 

Cylinder — This projects the unwrapped curves onto a cylinder 
from the target object. You can modify the cylinder in the 
graphics window. A chequerboard visual effect is displayed on 
the target object to show the effect of the unwrap method. 

UV — This option is not available when using the Unwrap Wizard. 

Cone — This option is selected automatically when creating a 360 
degree conical wrap. A chequerboard visual effect is displayed on 
the target cone object to show the effect of the unwrap method. 
For further details, see Creating a 360 degree conical wrap (see 
page 143) 

Reset — This reverts the settings back to the default values. 
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Next — Different pages of the wizard are displayed depending on the 
method that is selected: 

 Plane, Cylinder methods - the Curve Selection page of the Unwrap 
Wizard is displayed. 

 Chord method - the Chord Length Wrap Map Creation page of the 
Unwrap Wizard is displayed. 

 

Unwrap Wizard - Chord Length Wrap Map Creation 
Use this page to define how the Chord wrapper unwraps from the 
target object. 

 
The wrap map is a 2D coordinate system for a triangulated surface. 
It is displayed as a black and white chequerboard effect on the 
target object. 

Minimize Distortion — This enables you to select where to minimise 
the distortion caused by the unwrapping process. Select one of the 
following: 
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Radially — This option works most successfully with square 
shaped target objects. 

Along workplane X axis — This is the default option. This provides 
straighter lines and more even spacing along the X axis of the 
target object. 

Along workplane Y axis — This provides straighter lines and more 
even spacing along the Y axis of the target object. 

Globally — (recommended) minimises the distortion equally over 
the whole surface, preserving the shape of the wrapper as well 
as possible. When this option is selected, Wrap Precision is 
unavailable. 

 This method is suitable only for open targets; the target 
cannot be closed or tubular. The target may contain holes. 

Wrap Precision — Move the slider to adjust the precision of the wrap 
map to reduce distortion if necessary. Higher gives the best wrap 
quality but the wrap map takes longer to create. The default 
position is Normal. 
Wrap Stiffness — Move the slider to adjust the wrapping angle. 
Maximum stiffness reduces wrapping angles and preserves large 
map areas. Minimum stiffness increases wrapping angle of the wrap 
map for greater curvature. The default position is Normal. 

Preview — This creates the wrap map and displays it as a 
chequerboard effect on the target object. 

Next — The Curve Selection page (see page 160) of the Unwrap 
Wizard is displayed. 

 

Unwrap Wizard - Curve Selection 
Use this page to choose the types of curve to be unwrapped. 
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Dependent curves — This unwraps the dependent curves. These are 
curves that have a relationship with a surface. 

Trim boundaries — This is the defining outer edge of the target 
object. 

Patch boundaries — This unwraps the internal laterals and 
longitudinals that are displayed visibly on the surface. 

Next — The Unwrap Curves page (see page 161) of the Unwrap 
Wizard is displayed. 

 

Unwrap Wizard - Unwrap Curves 
Use this page of to preview and finish the unwrap. 

 
Select the destination workplane for the unwrapped curve from the 
following: 

Unwrap — This is the default workplane. 

World — Refers to the world workplane. The curves will be 
positioned relative to the world workplane when it is unwrapped 
from the target object. 

Preview — This unwraps and positions the curves on the selected 
workplane. This enables the unwrapped curves to be modified and 
then wrapped back onto the target object using the Rewrap Wizard. 

Finish — Completes the unwrapping process. 
 

Using the Rewrap Wizard 
When a surface is unwrapped and the additional design has been 
added, you rewrap the curves, symbols or triangles onto surfaces or 
solids. 

Use the following menu options to rewrap the items specified: 
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 Use the Wrap  button on the Curve toolbar to rewrap 
wireframe items. 

 Use the Wrap Triangles  button on the Surface toolbar to 
rewrap symbols or DMT files and to rewrap a triangle file onto a 
surface or solid. 

A selected surface that has previously been unwrapped is 
recognised automatically when you start the Wrap Wizard. The Wrap 
Wizard turns into the Rewrap Wizard and takes you through the 
Wrap Wizard pages to rewrap the item onto the target object. 

 You cannot rewrap onto a solid using the Solid Wrap option on 
the Feature menu, because the solid feature is not created. To 
rewrap onto a solid, use the Wrap Triangles option on the 
Surfaces menu. 

For further details, see What is Wrapping? (Surface modelling 
manual).  

 

Rewrap Wizard - Wrapper Selection 
Select the items to be rewrapped onto the target object. The Rewrap 
Wizard pages are the same as the Wrap Wizard pages and guide you 
through the rewrap process. 

 
Use settings from previous unwrap — This option is selected 
automatically if the selected surface or solid has been unwrapped 
previously. 

For further details, see What is Wrapping? (Surface modelling 
manual). 
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Rewrap Wizard - Wrap Wire 
If you are rewrapping wireframe objects, this page is where you 
apply the wrapper to the target object. 

 
Preview — Select to preview the results of the rewrap. 

Finish — This completes the rewrap process. 

 The Rewrap Wizard pages are the same as the Wrap Wizard 
pages and guide you through the rewrap process. 

For further details, see What is Wrapping? (Surface modelling 
manual).. 

 

Creating a Trimline 

 This option is available only in Toolmaker mode. 

You can create a Trimline using the option on the Curve toolbar. 

1 With PowerSHAPE running, click Module > Toolmaker. 
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2 Select Curve  from the main toolbar. The curve toolbar is 
displayed.  

 

3 Select Trimline  from the curve toolbar to display the 
Trimming Line Creation dialog (see page 165). 

4 Use the options in the dialog to create the trim line. 
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Trimming Line Creation dialog 
You can use this dialog to apply appropriate options to the selected 
flange and addendum surfaces 

 

Selection 
Flange - Select the flange surface (F). The cross  icon changes to a 
tick  icon.. On the model below, this surface is indicated by . If 
the flange surface contains holes, the trimming lines of these holes 
will be created as composite curves. 

Addendum - Select the addendum surface (A). The cross  icon 
changes to a tick  icon.. On the model below, this surface is 
indicated by  
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Compensations 
The values set in this section are incorporated into the calculation of 
the Trimline. 

Wall thickness - Thickness of the flange. If ON, the thickness (W) 
will be used when calculating the Trimline. 

Die - If ON, the wall thickness applies when you are creating a 
die. 

Punch - If ON, the wall thickness applies when you are creating a 
punch. 

Trimming Allowance - Additional allowance to ensure that there is 
sufficient metal to create the required flange surface. 

Analysis of bad regions 
Highlight bad regions - If ON, trim lines that are on a slope that is 
too steep will be highlighted. The slope of the addendum surface 
where the Trimline is created should be as gentle as possible. 

Maximum of good angle - If Highlight bad region is ON, you can 
enter an angle. Any Trimline that is created on a slope that is 
steeper than this angle will be highlighted. 

 

Editing a curve 
Edit curves, composite curves, and surface curves using one of the 
following methods. 

 Select the curve. 

Select a point on the curve to display its graphical handles. Use 
the following menus to select one of the various graphical 
handles: 
 Edit > Surface and Curve Edits > Common Edits > Selected Point 

Graphical Handles 

 Curve point context menu 

Use its graphical handles to edit the curve. 

Select multiple points. Any edits that apply to a particular point 
are carried out on all the selected points. If no points are 
selected, then the edits are carried out on all the points. 

 You can reposition the points on the curve. 

With a curve selected, choose one of the following options from 
the Edit menu. 

Edit > Convert > To wireframe breaks a composite curve into its 
individual wireframe objects. 

Edit > Modify displays the Curve edit toolbar. 
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Edit > Surface and Curve Edits > Curve edits > Delete Dependencies 
removes any dependencies from a curve or composite curve. 

 Double-click the curve to display the Curve edit toolbar (see page 
181). Commands on this toolbar can also be reached via Edit > 
Surface and Curve Edits > Curve Edits. 

If a curve can be edited as a B-spline curve, the Edit as Bezier or 

B-spline  button is available on the Curve edit toolbar. 

If it can be edited as a G2 curve, the G2 Edit  button is 
available on the Curve edit toolbar. 

 Right-click the curve to display the edit options available for 
curves. The name of the curve and the level on which it lies is at 
the top of the menu. 

 
The following options are unique to the curves: 
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Delete Dependencies — When a curve or composite curve is 
created on an object (for example, a surface), it may be 
dependent upon that object. This option removes any such 
relationships that may exist between the curve and other 
objects. 

Edit as a Bspline Curve — If a curve can be represented in B-
spline form, this option lets you to edit it using the B-spline 
handles or as a Bezier. 

Edit Tangent Angles... — This displays the Tangent Editor dialog, 
which lets you to edit the tangent directions and magnitudes 
of curves. 

Free Magnitudes — This frees tangent magnitudes through 
selected points along a curve. If no points are selected, the 
whole curve is freed. 

Free Tangents and Magnitudes — This frees the tangent 
directions and magnitudes through selected points along a 
curve. If no points are selected, the whole curve is freed. 

The menu for composite curves contains an additional option: 

Convert to Wire — This breaks a composite curve into its 
individual wireframe objects. 

 

Graphically editing curves 
To graphically edit a curve. 

1 Select a curve. 

2 Select a point on the curve to display its default handles. 
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3 Right-click on the point to display the curve point menu. 

 
4 Select one of the following handles: 

 Tangent and magnitude graphic handles (see page 170). 

 Tangent and normal graphic handles (see page 171). 

 Workplane graphic handles (see page 173). 

 Offset graphic handle (see page 174). 

Use these handles to: 

 move the point. 

 insert new points on the curve. 

 edit the properties of the curve either side of the point. 

When editing surface curves, graphical handles are present for 
both the laterals and longitudinals at the selected point. 
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Dependent curve points on a curve are drawn with a large 
crossed circle instead of a small circle. 

 
5 Select any handle and drag it to a new position. 

 You can graphically edit multiple points simultaneously by 
selecting multiple points and using the graphic handles as you 
would for single curve points. 

 

Tangent and magnitude graphic handles 
1 Select a point on the curve. 

2 To display the context menu  the point. 

3 Select Tangent and magnitude graphic handles from the context 
menu. 

 

4 To edit the curve  the various handles: 

 Use the arced handles  to modify the tangent angle of the 
curve, without changing the magnitude. A circle is drawn in a 
fixed plane relative to its starting position. 
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 Use the spherical handles  to freely modify the magnitude 

of the curve in any direction. 

  
 Use the arrow tip handles  to modify the magnitude of the 

curve along the fixed tangent. 

  
 Use the centre handle  to move the curve point freely. 

  

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Tangent and normal graphic handles 
1 Select a point on the curve. 

2 To display the context menu  the point. 
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3 Select Tangent and normal graphic handles from the context 
menu. 

 
4 To edit the curve, drag the various handles: 

 Use the arrow handles tangent to the curve  to move the 
point, in a fixed direction, along the tangent. 

  
 Use the arrow handles normal to the curve  to move the 

point, in a fixed direction, along the normal. 

  
 Use the planar handles  to move the point across a 2D 

plane. 

  
 Use the centre handle  to move the point freely. 
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 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Workplane graphic handles - curves 
1 Select a point on the curve. 

2 Right-click on the point to display the Curve point menu. 

3 Select Workplane graphic handles from the context menu. 

 
4 To edit the curve, drag the various handles: 

 Use the workplane arrow handles  to move the point along 
a fixed axis. 

  
 Use the workplane centre handle  to move the point freely. 
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 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Offset graphic handle 
Use the Offset graphic handle to graphically modify a single 
wireframe curve, or composite curve, point. 

1 Select a point on the wireframe. 

2 Right-click the point and select Offset graphic handle from the 
Curve or Composite Curve context menu. 

 
3 Click and drag the handle to edit the wireframe: 

Before 

 

 

After 

 

The point is offset a set distance away from its original position. 

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Moving points 
When you drag the handle for the position of a point, the point 
moves in a plane through itself where the plane is parallel to the 
principle plane of the current workspace. 
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 If spans are straight on either sides of the point and not 
collinear, they are still straight when the point is moved. 

 
If spans are straight on either side of the point and collinear, 
tangent continuity is preserved through the point. 

 
If the point is on a surface, you can hold down the Shift key and 
drag it along the laterals and longitudinals on the surface. The 
tangent handles change to reflect the tangents on the surface as 
the point is moved. This results in the surface changing shape far 
less. 

 

Inserting new points 
If you press and hold the Ctrl key and drag the handle for the 
position of a point, a new point is inserted onto the curve. If the 
point is on a surface, a new curve is added too. 

 

Editing the tangent direction and magnitude 
The handles for the control points edit both the tangent directions 
and magnitudes of the curve. When you drag these handles, the 
magnitude value is displayed on the screen. To edit only the 
magnitude, drag the handle so that it does not waver more than 5  
either side of the original direction. Deviations greater than this 
cause the tangent direction to change too. 
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If you look closely at the tangent direction handle, which is the line 
between the curve point and the control point, you will notice that it 
is two colours. 

 
The half nearest the control point edits only the tangent direction 
before (or after) the point, whereas the other half edits both the 
tangent direction before and after. When these handles are 
dragged, the magnitude remains constant. 

If you click or drag the handle for the tangent direction before and 
after, then the tangent direction handle on the other side of the 
point is forced to line up with the selected handle. 

 

Graphically selecting points on a curve or power surface 
Select the curve or power surface and display its points. When you 
select a curve, its points are not labelled by default. The points are 
labelled here to identify individual points. 

You can label points on curves by selecting the Point labels  
button on the Curve Edit toolbar.  

 
The following methods can be used to select points: 

 Clicking a point selects it and displays its graphical handles. 
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Click point 3 to select it and display its graphical handles. 

 
 Shift + click adds a point to the selection. 

 The last point selected is used when moving the points in 
world workspace. 

If we now Shift + click point 4, it is marked with a star enclosed 
in a circle to show that it is the last point selected. Point 3 no 
longer displays its graphical handles and is marked with a circle 
to show that it is selected. 

 
 Ctrl + click - removes a point from the selection if is already 

selected, otherwise it is added to the selection. 

If we Ctrl + click point 5, it is added to the selection. It is now 
marked as the last point selected and point 4 is marked with a 
circle to show that it is still selected. 

 
 Shift + Ctrl + click removes a point from selection.  
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Use Shift + Ctrl + click to remove points 3 and 4 from the 
selection. Since point 5 is the only point selected, it displays its 
graphical handles. 

 
 You can similarly use the Shift and Ctrl modifier keys with box 

selection to add and remove points from the selection. 

 Pressing the Shift key and box selecting any part of the curve or 
power surface adds any points within the box to the selection. 

Press the Shift key and box select points 2 and 3. 

 
One of the points in the box selection becomes the last point 
selected. In this case, point 3 has become the last point selected. 

 Similarly, pressing the Ctrl and Shift keys at the same time and 
box selecting removes points from the selection. 

 If you use the Shift and Control modifier keys and box select 
objects other than the selected curve or power surface, 
nothing happens. If you want to select other objects, you 
must first Shift + click any one of the other objects. 
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Moving points 
1 Select one or more points on the curve or power surface. 

 
The last point selected is used when moving the points in world 
and workplane workspace.  

To change the last selected point, Ctrl + double-click another 
point in the selection. 

In this example, point 3 is the last selected point. 

2 Click the Position  button to display the Position dialog. 

3 Use the Position dialog to edit the position of the points. 

On the Position dialog, you can choose the Workspace as world, 
workplane or relative. 

If you choose world or workplane, the last selected point moves 
to the new position you define on the Position dialog. All the 
other points move by the same distance the last selected point 
moves. 

Enter the values -50 0 0 in the Position dialog. Point 3 moves to 
position -50 0 0 and the other points follow. 

 
If you choose relative, then the new position you define on the 
Position dialog defines the relative distance for all the points to 
move. 

 If spans are straight on either side of the point and not 
collinear, they are still straight when the point is moved. If 
spans are collinear too, tangent continuity is preserved 
through the point. 
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Keeping straightness of spans 
The Keep straightness of spans option is available from:  

 The Curve Edit context menu. 

 The Edit menu as shown below. It enables you to keep a span 
straight when you edit a point.  

 
If the Keep straightness of spans option is selected and you edit a 
point that is at the end of a straight span, the straightness of the 
span is preserved. 
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If the Keep straightness of spans option is deselected the 
straightness of the span is not preserved. 

 

 If three points are collinear and you edit the middle point, the 
straightness is never preserved. 

 

Renaming a curve 
By default, each curve is given a unique number. You can change 
this to a name of your choice in the same way as you can for other 
objects. 

1 Select a curve. 

2 Select Rename from the context menu or from Edit > Surface and 
Curve Edits > Common Edits. The Curve Name dialog is displayed. 

 
3 In the Name text box, type the new name for the curve. 

4 Click OK. 
 

Using the Curve Edit toolbar 
1 Select a curve to display the Curve Edit toolbar. 

The options that are available are grouped to reflect the type of 
curve you have selected and the type of curve editing you are 
doing. 

2 Select the mode of curve editing from the flyout . This 
determines the appearance of the Curve Editing toolbar. The 
following modes are available: 

 Edit the curve in 3D (see page 182) (default). This contains 
the main curve editing functionality  

 Edit the curve in 2D (see page 217)  
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 Edit the curve using active dimensions (see page 224). The 
active dimension options from curve editing toolbar in the 
previous version are available in this mode. 

 
3 Select the editing option required. 

 

Editing a curve in 3D 

1 Select the Edit the curve in 3D  button on the Curve Edit 
toolbar. 

 
2 The 3D Curve Editing toolbar is displayed. The buttons that are 

active on the toolbar below depend on the type of curve you are 
editing. 

 
3 Edit the curve using the options below. 

 Reverse (see page 199) — Click this button to reverse the 
curve. 

 Close (see page 202) — Click this button to close the curve. 

 Open (see page 201) — Click this button to open the curve. 

 Renumber points (see page 200) — Click this button to 
renumber the curve points. 
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 Spline (see page 202) — Click this button to spline the 
curve. 

 Join (see page 212) — Click this button to join two curves. 

 Select points (see page 184) — Click this button to select 
points on a curve. 

 Create point (see page 185) — Click this button to create a 
curve point. 

 Delete point (see page 185) — Click this button to delete a 
curve point. 

 Label points (see page 198) — Click this button to label 
curve points. 

 Curvature combs (see page 198) — Click this button to 
create curvature combs. 

 Tangent angle (see page 190) — Click this button to edit the 
tangent angle. 

 Fine tune (see page 214) — Click this button to fine tune the 
curve. 

 G2 edit (see page 96) — Click this button to edit a G2 curve. 

 Merge and spline (see page 204) — Click this button to 
merge and spline a curve. 

 Fit arcs to curves (see page 204) — Click this button to fit 
arcs to a curve. 

 Arc fitting (see page 205) — Click this button to fit arcs and 
lines to planar curves. 

 Repoint (see page 207) — Click this button to repoint a 
curve. 

 Edit as Bézier (see page 214) — Click this button to edit the 
curve as a Bézier curve. 
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 Edit as B-spline (see page 214) — Click this button to edit 
the curve as a B-spline curve. 

  Smoothing (see page 216) — Use this toggle button to 
control smoothing. 

  
 

Selecting a point on a curve 
1 Select the curve. 

2 If you are selecting points on surfaces, select all the curves from 
which you want to select points. 

3 Click  from the Curve Edit toolbar. 

4 Use the Select Points (see page 184) dialog to select points. 
 

Select Points dialog 
This selects points on curves. 

 
Surface - (Only valid for surface curves) This is name of the surface 
whose curves are displayed in the Curve list. You can select another 
surface and its selected curves are displayed in the list of curves. 

Curve - This is the name of the curve whose points are displayed in 
the Points list. You can select another curve and its points are 
displayed in the list of points. 

Points - These are the points on the curve named in the Curve 
selector. You can select points from the list by clicking to select 
single points, Shift + click to add a point to the selection and Ctrl + 
click to toggle a point from the selection. Selected points are 
highlighted on the screen. 
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When you choose another surface or curve from the selector, 
PowerSHAPE remembers the selected points of the previously 
selected surfaces. 

OK - Removes the dialog from the screen. You can keep the dialog 
displayed while you edit the points. 

You can also graphically select multiple points. 
 

Deleting points on a curve 
To delete points on a curve: 

1 Select a curve to display the points. 

 
2 Select one or more points on the curve. 

 

3 Click  (Curve edit toolbar). 

The selected points are deleted and the remaining points on the 
curve are renumbered. 

 

 If all the points are selected except one, then no points are 
deleted. 

 

Creating a point on the curve 

1 Click  (Curve edit toolbar). 
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2 Use the Insert point into curve dialog to insert a new point into the 
curve. 

 
The following methods are available: 

 Parameter value (see page 186) 

 Through nearest point (see page 187) 

 Distance from point (see page 188) 

 Workplane intersection (see page 188) 

Apply - Inserts a new point in the curve. 

OK - Removes the dialog from the screen. 

 When you insert points in B-spline curves, the shape may 
change significantly. 

 

Insert point into curve - Parameter value 
This inserts a point at a specific parameter value. 

When the Parameter Value tab is selected, the Insert point into curve 
dialog displays the following page. 

 
Value - Input the parametric value of where you want the new point 
to lie. 
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Suppose we wanted to add a new point half way between points 1 
and 2. 

 
We input a Value of 1.5. This is the parametric value half way 
between points 1 and 2. 

Apply - Inserts the new point. This also renumbers the other points 
to reflect the change. 

In our case, a new point is added halfway between points 1 and 2. 
This point is numbered 2 and point 2 has become point 3. Point 2 
now becomes the selected point. 

 
If you want to add another point halfway between 3 and 4, you 
need to enter 3.5. The points are then renumbered. 

 

Insert point into curve - Through nearest point 
This inputs a point on the curve nearest a specified point. 

When the Through nearest point tab is selected, the Insert point into 
curve dialog displays the following page. 

 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

Apply - Inserts the new point on the curve. This also renumbers the 
other points to reflect the changes. 
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Insert point into curve - Distance from point 
This inputs a point on the curve at a specified distance from the 
currently selected point. If no point is selected then point 1 is used. 

When the Distance from point tab is selected, the Insert point into 
curve dialog displays the following page. 

 
Distance - Input the distance from the current point where you want 
the new point to lie. 

To add a new point 10 units from point 1, input the Distance as 10. 

 
Apply - Inserts the new point. This also renumbers the other points 
to reflect the change. 

The new point becomes the current point. 
 

Insert point into curve - Workplane intersection 
This inserts a point where the principal plane of an active workplane 
intersects a point. 



 

PowerSHAPE 2015 R2 Reference Help Wireframe modelling • 189  

When the Workplane Intersection tab is selected, the Insert point into 
curve dialog displays the following page. 

 
The YZ plane of the active workplane is displayed as intersecting the 
curve at point 3. 

 
Offset - Enter a value from the workplane where you want the new 
point to lie on the curve. The plane graphic updates to show the 
new value. 

Apply - Inserts the new point. This also renumbers the other points 
to reflect the change. 

In the example below, an offset value of 20 was entered. A new 
point is added where the YZ plane of the active workplane intersects 
at the offset point. 

 
The new point is numbered 4 and the other points are renumbered. 
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Setting the position of the current point 
1 Select a point on the curve. 

2 Click  on the status bar to display the Position dialog. 

3 Use the dialog to edit the position of the selected point. 

 If you move a point that defines a straight span, the span 
remains straight. 

 

Setting/freeing tangents at the selected points 
1 Select a curve or points on a curve. 

2 Click  (Curve edit toolbar). 

3 Use the Tangent Editor dialog (see page 190) to edit the 
tangents. 

 

Tangent Editor dialog 
Whilst the dialog is displayed, select the curves and curve points 
you want to edit using the following: 

 graphical editing techniques. 

 options on the Surface/Curve Edittoolbar . 

 

Using the Tangent Editor dialog 
Use this dialog to edit the tangents at the selected points. 
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Set tangents Along/Across curve - (Surface curves only) This allows 
the tangents at the selected points to be set along or across the 
curve in the current surface direction. For non-surface curves, this 
selector is fixed at Along.  

 Tangent editing works with multiple curve selections. 

Tangent - Edits the tangent directions. 

Choose one of the following to indicate which tangent direction you 
wish to edit: 
 Before and After 
 Before 
 After 
Seven buttons are provided to help you edit the tangent directions: 
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 - To set the tangent direction precisely, click this button to 
display the Direction dialog. Fill in this dialog with new direction 
values and press OK 

 - This straightens spans before or after the selected points. If 
a whole curve is selected, then all its spans are straightened. 
Surface curves are only straightened 'along' the surface. 

 - If you choose Tangent as Before or After, then you may edit 
the position of the control point for that tangent. To do this, click 
this button to display the Position dialog. Fill in this dialog with 
new position data for the control point and press OK. 

Free - This frees the tangent directions (before and after) to fit a 
smooth curve through each selected point. If tangent magnitudes 
are assigned, just the tangent directions are recalculated. 

 - (Laterals/longitudinals only) To set the plane in which the 
tangent direction lies, click this button to display the Direction 
dialog. Fill in this dialog and press OK. This sets the plane's 
normal. 

 - (Laterals/longitudinals only) To set the flare and twist 
angles, click this button to display the Flare/Twist Editor dialog 
(see page 195). 

 - To set the azimuth and elevation angles, click this button to 
display the Azimuth/Elevation Editor dialog. 

This edits azimuth and elevation angles on all curve points. 

 
The azimuth and elevation angles are measured using the principal 
plane. To help explain azimuth and elevation angles, we will assume 
that the principal plane is the XY plane. Therefore, the Z axis is 
perpendicular to the principal plane. 
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Azimuth - If you look vertically downward onto the XY plane, the 
azimuth  is the angle made by the tangent of the curve and the X 
axis . 

 
It can take any value in a 360  range, but you may find it easier to 
work with values in the range -180  to +180 . For example, azimuth 
angles of 270  and -90  are the same. 

Elevation - The elevation angle  is the one between the tangent of 
the curve and the XY plane . 

 
Elevation angles make sense only between 0  and 90 , and between 
270  and 360 . You can enter any angle for elevation, it will be 
displayed as the equivalent angle between the two valid ranges. For 
example, if you enter a value of -45 , the elevation is displayed as 
315  in the dialog. 
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 If the elevation angle is 90  or 270  (that is along the Z axis), 
you cannot modify the azimuth angle. 

 - Align the before and after tangents. 

Magnitude - Edits the tangent magnitudes. Choose one of the 
following to indicate which tangent magnitude you wish to edit: 
 Before and After 
 Before 
 After 
You may enter a value for the magnitude in the text box provided. 

Free - This frees the magnitudes to fit a smooth curve through each 
selected point. 

Scale Magnitude - This edits the tangent magnitudes by scaling the 
values using the slider. The higher the value, the fuller the curve. 

In the example below, the slider value is 1. 

 
If we increase the value to 2, the curve grows larger as the 
magnitudes increase. 

 
If we decrease the value to 0.5, the curve tightens as the 
magnitudes decrease. 

 
The scale display always resets to 1 when the directions or type of 
edit are changed on the dialog. This does not affect the magnitudes 
of the curve. 
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 The number of curves and points selected are displayed within 
the dialog. 

Apply - Saves the changes made to the tangent without closing the 
dialog. 

OK - Saves the changes made to the tangents and removes the 
dialog. 

Cancel - Discards any edits made to the curve whilst the dialog was 
open and closes the dialog. 

 

Flare/Twist Editor dialog 
This edits the flare and twist angles. 

 
You can modify the flare and twist angles, that are defined either 
along a longitudinal or across a lateral. 

Flare and twist can only be modified if 

 surface curves or points on surface curves are selected; or 

 the surface has a spine. (You can create a spine using the Create 

spine button  on the Surface editing toolbar). 

Flare - The flare angle defines the direction of the longitudinal 
tangent relative to the spine tangent. 
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If the flare angle is positive, the longitudinal diverges from the 
spine; if it is negative, the longitudinal converges with the spine. 

Twist - Twist forces the longitudinal to twist about the spine. 

 
If the twist angle is positive, the longitudinal rotates in an 
anticlockwise direction as it passes through the lateral. 

 

Azimuth/Elevation Editor dialog 
This edits azimuth and elevation angles on all curve points. 

 
The azimuth and elevation angles are measured using the principal 
plane. To help explain azimuth and elevation angles, we will assume 
that the principal plane is the XY plane. Therefore, the Z axis is 
perpendicular to the principal plane. 
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Azimuth - If you look vertically downward onto the XY plane, the 
azimuth  is the angle made by the tangent of the curve and the X 
axis . 

 
It can take any value in a 360  range, but you may find it easier to 
work with values in the range -180  to +180 . For example, azimuth 
angles of 270  and -90  are the same. 

Elevation - The elevation angle  is the one between the tangent of 
the curve and the XY plane . 

 
Elevation angles make sense only between 0  and 90 , and between 
270  and 360 . You can enter any angle for elevation, it will be 
displayed as the equivalent angle between the two valid ranges. For 
example, if you enter a value of -45 , the elevation is displayed as 
315  in the dialog. 
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 If the elevation angle is 90  or 270  (that is along the Z axis), 
you cannot modify the azimuth angle. 

 

Labelling points on curves 
You can display the labels of the points on selected curves. 

 
To turn on curve point labels: 

1 Select a curve. 

2 Click  (Curve edit toolbar). The icon of the button changes to 

this . This indicates that the option is switched on. 

The points are now labelled on any selected curves. 

3 To stop displaying the labels, select a curve and click . 
 

Curvature combs on curves 
You can display curvature combs on selected curves, composite 
curves and surface curves. 

 
Curvature combs represent the curvature along a curve. The 
curvature combs are shorter where there is less curvature and 
larger where there is more curvature. 

By default, two curvature combs are drawn: one along the normal 
to the curve and the other along the normal to the view. You can 
decide which curvature combs to display using the options on the 
Curve Analysis page of the Options dialog. 
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Curvature combs along the normal to surface curves represent the 
normal curvature along the curves and point along the normal to 
the surface . 

 
To display curvature combs: 

1 Select a curve. 

2 Click  (Curve Edit toolbar). The curvature combs are drawn 
on any selected curves. 

To stop displaying curvature combs, select a curve and click the 

Curvature combs on/off button . 

You can set the size and density of the combs using the Comb 
Scale option on the Curve Analysis page of the Options dialog. 

 

Reversing a curve 
You can reverse the numbering of the points in selected curve. 

To reverse a curve: 

1 Select a curve. 

 
You can select multiple wireframe curves and composite curves 
to reverse in one go. 
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2 Click  (Curve Edit toolbar). 

 
If a closed curve is reversed, the first point remains the same. 

 If you reverse a composite curve made from a surface, all the 
normal information is remembered. 

 

Renumbering a curve 
Points in a curve may be renumbered so that the selected point 
becomes numbered one. The curve must be closed. 

To renumber a curve: 

1 Select the point you want numbered as one. 
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2 Click  (Curve edit toolbar). 

 
 

Opening a curve 
You can create an opening between the first and last points in a 
closed curve. 

To open a curve: 

1 Select a curve. 

 

2 Click  (Curve edit toolbar). 
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Closing a curve 
You can close a curve between the first and last points of an open 
curve. 

To close a curve: 

1 Select a curve. 

 

2 Click  (Curve edit toolbar). 

 
 

Splining curves 
Splining smoothes curves to give tangency continuity on selected 
points. (Tangent continuity is a smooth change in tangent direction 
as you move across the curve). The positions of the selected points 
are changed during this operation. 

To spline a curve: 

1 Select a curve. 
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Select the points on the curve to 
be splined (smoothed) . 

 
At least two points must be selected on the curve. On open 
curves, the start or end points must not be selected. 

2 Click  (Curve edit toolbar). 

 

 If you have not selected points, or the current selection of 
curve points is not correct, you can select different curve 
points using the Select Point dialog or use the mouse to 
select curve points.  

3 Use the options on the dialog to spline the points on the curve. 

Position new points near to original location - If selected, the 
points are positioned near their original locations on the splined 
curve. 
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Otherwise, they are evenly distributed along the splined curve. 

 
Preview - If you are not sure how to position the points, click the 
Preview button to see what the curve will look like. 

4 Click OK. 
 

Merge and spline curve 
In composite curves, merge and spline removes gaps and redefines 
points within tolerance. In curves, merge and spline just redefines 
points within tolerance. 

To merge and spline a curve: 

1 Select one or more curves. 

 

2 Click  (Curve edit toolbar). 

 
3 You can change the tolerance to which the curve is merged and 

splined using Tol on the Status bar. 
 

Arc fitting 
You can fit arcs to curves using one of the following methods: 

 Fitting arcs to curves (see page 204). 

 Fitting arcs and lines to planar curves (see page 205). 
 

Fitting arcs to curves 
You can fit arcs to curves. 
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1 Select one or more curves. 

2 Click  (Curve edit toolbar). 

The curve is converted to a composite curve and the underlying 
geometry of the composite curve contains the fitted arcs. 

If all the composite curves have been successfully arc fitted, the 
following message will be displayed. 

 
If any composite curves have failed to be arc fitted, an error 
message is displayed, listing all the names of the failed 
composite curves. 

 Tol on the Status bar changes the tolerance. At low tolerances, 
a large number of arcs may fit a curve. To reduce the number 
of arcs, increase the tolerance. 

 

Fitting arcs and lines to planar curves 
The Arc Fitting tool simplifies and re-fits composite curves with arcs 
and lines. 
Before Arc Fitting 

 

After Arc Fitting 

 

 

Use the Arc Fitting tool to simplify composite curves that have been 
created from meshes, solids, or surfaces. Creating surfaces and 
solids from wireframe becomes much easier by converting a 
composite curve with many points, into a collection of arcs and lines 
with few points. 

You can control the Arc Fitting settings using the Arc Fitting dialog 
(see page 206). 

Access Arc Fitting from the: 
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 Surface/Curve Edit toolbar. 

 Dynamic Sectioning dialog. 

 Oblique dialog. 

 

Surface/Curve Edit toolbar 

Select the Arc Fitting  button to display the Arc Fitting dialog 
(see page 206). 

Dynamic Sectioning dialog 
Select the Arc fitting option to automatically apply Arc fitting to any 
curves created using the dialog. 

Select the Arc fitting options  button to display the Arc Fitting 
dialog (see page 206). 

 A preview of the original curve is shown when using Arc 
Fitting from the Surface/Curve Edit toolbar. 

Oblique dialog 
Select the Arc fitting option to automatically apply Arc fitting to any 
curves created using the dialog. 

Select the Arc fitting options  button to display the Arc Fitting 
dialog (see page 206). 

 

Arc Fitting dialog 
Use the Arc Fitting dialog to change the Arc fitting settings: 

 
 Select workplane — If a workplane is not selected then the best-

fit workplane is used. You can select a workplane to use, and the 
curve will be projected onto its XY plane. 



 

PowerSHAPE 2015 R2 Reference Help Wireframe modelling • 207  

 Align angle — This option controls alignment of lines within the 
workplane. Lines that lie close the principal axes with an angle 
less than the entered value, are snapped to the principal axes. 
Set to 0 to disable principle axis alignment. Takes values 
between 0 and 10. 

 Discontinuity angle — Enter a value to set the maximum angle 
allowed between lines on the composite curve. If the angle 
between two lines is greater than this angle, additional spans are 
added to reduce the angle. Takes values between 0 and 90 
degrees. 

 Maximum radius — Enter a value to set the radius limit at which 
arcs will be drawn. Curves with a radius greater than this value 
become arcs, and curves with a radius lower than this value 
become lines. 

 Fit — Use the slider to control the fit tolerance. A Low fit 
sacrifices quality by increasing simplicity and reduces the number 
of curves. A High fit sacrifices simplicity by creating more curves, 
however retains a high accuracy to the original curve. 

 

Repointing curves 
You can change a segment of a curve or a composite curve to 
contain a certain number of points, which lie equidistant from each 
other. 

For a surface curve, you can only redistribute its points between 
two points, but not insert new ones. 

To repoint a curve: 

1 Select one or more curves. 

 
You can only repoint multiple curves on a single surface and all 
the curves must lie in the same direction. 

2 Click  (Curve Edit toolbar). 
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3 Use the Repoint curve dialog (see page 208) to redistribute the 
points along the curve. 

 

Repoint curve dialog 
Use this dialog to redistribute points along a curve. 

 
Repoint between — The options in this section are used to define the 
points that you want to repoint: 

Start point and End point — You can select the start and end points 
of the segment of the curve where you want to repoint. By default, 
the start and the end points of the curve are given . Markers are 
automatically placed at the named points. 

 
Number of points in range — (Wireframe curves and composite 
curves only.) This is the number of new points that are added to the 
curve and evenly distributed between the start and end points. 
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In this example, point 3 is selected as the Start point and point 5 
as the End point. 

 
If you enter 6 as the Number of points in range value, the 
following curve is produced: 

 
Behaviour at corners — (Wireframe curves and composite curves 
only.) You can select points that you don't want to remove. These 
points are marked as corners. 

If we have no corners selected and use the default settings (that 
is, Start Point = 1, End Point = 7 and Number of points in range = 
7), we get the following curve. 
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 New points are added equidistant from each other. 

 All original points are removed from the curve. 

 The tangent magnitudes of the new points are freed. 

When corners are added, the same thing happens except the 
corner points remain fixed in the curve. 

 Corner points are not included in the points in the Number 
of points in range. 

Behaviour at corners option menu has three options: 

 Selected corners — This option enables you to select corners. To 
select corners, select this option and click points. 

In this example, point 2 is selected. A corner marker is added to 
the curve. 

 
This creates the following curve. 

 
You cannot select corners on multiple wireframe curves using the 
Select corners option, but you can choose the Keep all 
discontinuities option to add corner points. 

 Remove all corners — This removes all corners from the curve. 
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 Keep all discontinuities — This adds corner markers at all 
discontinuities along the curve. Any other corners already 
marked, remain marked. 

In this example, points 2 and 6 are discontinuous and are 
therefore marked as corners. 

 
This gives the following curve. 

 
To remove a corner marker, click the corner. 

Repoint by spacing — Select this option to repoint a curve using a 
spacing defined method: 

 Global even — This option repoints the curve by spacing the 
points evenly along the curve, depending on the curve length 
and the number of points. A larger number of points provides a 
more accurate repoint. 

 Regular — This option repoints the curve by taking the smallest 
distance between two points and uses this spacing along the 
whole curve, between the currently existing points. 
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 Linear — This option repoints the curve by taking the smallest 
distance between two points and uses this spacing along the 
whole curve, between the currently existing points. The spacing 
is stretched and compressed slightly between the existing points 
to provide a linear blend. 

Repoint by tolerance — Select this option to repoint the curve to fit a 
specific tolerance. When this option is selected the number of points 
is automatically calculated by PowerSHAPE. 

Statistics — The fit accuracy of a repointed curve to the original 
curve is represented by the following values: 

 Maximum deviation — the maximum value that the repointed 
curve varies from the original curve. 

 Mean deviation — the average value that the repointed curve 
varies from the original curve. 

 Standard deviation — a representation of the amount of variation 
from the mean. 

Preview — Updates the Statistics area with the repointed curve 
data. The original and repointed curves are also displayed. 

  

OK — Saves the changes made to the curve and removes the 
dialog. 

Cancel — This makes no changes to the curve and removes the 
dialog. 

 

Appending curves to form a single curve 
You can append: 

 any wireframe object to a composite curve 

 a curve to a curve 

If the ends of the two objects do not join, a span is added to the 
ends. 

To append a curve: 
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1 Select a curve. 

 

2 Click  (Curve Edit toolbar). 

 
3 Choose the object to append. 

If you are appending to a composite curve, any wireframe object 
can be selected. If appending to a curve, only a curve can be 
selected. 

The  next to Select object to append changes to . 

By default, the ends of the objects nearest to each other are 
appended. If the two ends don't touch, they are joined by a 
span. The tangency at the ends of the new span matches the 
ends of the existing objects. 

 
4 If this is not the solution you want, select Next on the dialog to 

give the other solutions. 

As you click Next, the other solutions are displayed on the 
screen. 

5 Once you have the required solution, click either Apply or OK. 

If you want to append more objects to the current curve, click 
Apply and then select another object. 
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If you do not want to append any more objects, click OK. 
 

Editing a curve as a Bezier or B-spline curve 
You don't have to create a B-spline curve to use the B-spline control 
points. If a curve or surface curve can be represented in B-spline 
form, you can edit it as a B-spline curve. 

You can switch a curve from one form to another using the Edit as 

Bezier or B-spline button (  or ) on the Curve edit toolbar. This 
button is only available if the curve can be represented in B-spline 
form. 

If you alter the Bezier handles on a B-spline curve, it may no longer 
be represented as a B-spline curve. 

 Remember that many of the buttons on the Curve edits 
toolbar are not available when editing a curve as a B-spline 
curve. 

 

Fine Tuning 
You can use fine tuning to slightly move points on a curve, 
composite curve and surface curve. 

To fine tune a curve: 

1 Select points on the curve. 

2 Click  (Curve edit toolbar). 

3 Use the Fine Tuning dialog (see page 214) to move the point as 
required. 

 

Fine Tuning dialog 
Use this dialog to slightly move points on a curve, composite curve 
and surface curve. 
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Step size - This is the increment that the point will move each time 

the small up arrow  or down arrow  is clicked. The value can 

be entered either as a percentage  of the Maximum or as actual 

units . 

 

 
Maximum - This value is the maximum distance that the point can 
be moved from its original position. If this is locked , you can only 
move the point to a position that is less than this value from the 
original position. If this is unlocked , there is no limit to how far 
you can move the point. 

 - These arrows allow you to move the point up or down. 
Each click on a small arrow moves the point in X, Y and Z by the 
increment specified in Step Size. Each click on a large arrow moves 
the point by five times the increment specified in Step Size. 

You can also use the up and down cursor keys on the keyboard to 
move the point by the increment specified in the Step Size. 

 - These buttons allow you to independently lock/ unlock 
movement in the X, Y or Z direction. 

Comb Scale - This sets the size of the curvature combs displayed. 

You can display them by selecting the Curvature combs button  
(Curve edits toolbar). 

OK - Saves the edits made to the curve and removes the dialog 
from the screen. 
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Keep smooth 
Keep smooth applies extra smoothing to and around points as they 
are edited in an attempt to keep the shape of the curve smooth. 
This is done by freeing tangents and magnitudes about the edited 
points. 

1 Select a curve. 

 
2 Click the Keep Smooth button to turn it on or off. 

3 Edit the curve as necessary. 

If the Keep smooth option is OFF , only the original edit is 
done. This is the default. 

In our example, we have moved the selected point downwards. 
Here is the result if the Keep smooth option is OFF. 

 
If the Keep smooth option is ON, points on either side of the 
edited point (unless they themselves are being edited) have their 
tangent directions and magnitudes freed. 

Here is the result of our example if the Keep smooth option is ON 

.  

 
If the edit is positional only, the tangent directions and 
magnitudes at the edited point are also freed. 
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There are some limitations on the freeing of tangents. 

 If there is a discontinuity at the edited point, then neither the 
before nor after tangents are freed. The discontinuity is 
preserved. However, the magnitudes will be freed. 

 If there is a discontinuity at adjacent points, then only the inner 
tangent direction and magnitudes get freed, that is the after 
tangent on the point before and the before tangent on the point 
after. 

The Keep smooth option applies to position editing, tangent editing 
and the general edits (edit sub-components mode). 

 

Editing a curve in 2D 
To edit a curve in two dimensions: 

1 Select  Edit the curve in 2D from Curve Editing flyout. 

 
2 The 2D curve editing toolbar is displayed. 

 

 When entering 2D Editing, the program zooms 
automatically into the selected object. You can 
select/deselect this option using the Composite curve 
options dialog. 

3 Edit the curve using the options below. 

 Close curve (see page 202) 

 Open curve (see page 201) 

 Create point (see page 185) 

 Delete point (see page 185) 

 Merge and spline curve (see page 204) 
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 Fit arcs to curve (see page 204) 

  Apply smoothing (see page 216) 

 Add span (see page 218) 

 Delete span (see page 218) 

 Set mode - single dragging (see page 218) 

 Set mode - group dragging (see page 218) 

 Set mode - group dragging and keep angle (see page 218) 

 Set span width and angle (see page 218).  

Set selected corner radius (see page 218)  

  Switch solution for arc intersection (see page 222) 

 Change size of composite curve (see page 223) 
 

Using the 2D curve editor 
1 Ensure a composite curve is selected. 

 
2 Select Edit the curve in 2D.  

 When entering 2D Editing, the program zooms 
automatically into the selected object. You can turn the 
zoom setting OFF, or back ON, on the Composite curve 
options dialog. 
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 To zoom out, select Edit the curve in 3D  (curve edit 
flyout). 

3 Click Set Selected Corner Radius and enter a value of 15.  

 
The following are shown on the model above  

Point  

Span  

Radius  

4 Using the point indicated on the curve above, use each of the 
dragging modes in turn to modify the curve to help understand 
the differences between them. 

 Single dragging - A single point is dragged. Using this mode 
on the point indicated, you can produce a curve that looks 
something like the one below. The points either side of the 
dragged point retain their original position as indicated by arrows 
on the diagram below. 
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 Group dragging - Select one point and drag this. The rest of 
the points will be dragged, whilst maintaining the radius of the 
arc between the two adjacent points or angles where possible. 

 

 Group dragging and keep angles - The points beyond the 
selected point will be dragged, whilst maintaining the angle 
between the spans adjacent to the selected point. The constant 
angle is indicated by the arrow on the diagram below. 

 
5 Try changing the curve using the following: 

 Create a point - highlight a point and select Add a point  
button or Insert key. A point is inserted in the middle of the 
selected span 

 Delete a point - Highlight a point and select Delete a point  
button or the Delete key 

 Add a span - Use the Add a Span  button or the plus (+) 
key to add a span to the end of the previous span. The new 
span will have the same length and will be in the same 
direction as the previous span. 
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 Delete a span - Use the Delete a Span  button or the minus 
(-) key. 

 Changing the angles of spans - Click Set Selected Span Width 

and Angle  button to display the Span Angle dialog.  

 
 Setting a corner radius - You can change the radius at the 

selected point using the Set Selected Corner Radius  button 
to display the Radius dialog. An arc will be added if one does 
not already exist. 

 
 Locking/unlocking angles and lengths of spans - Locked 

dimensions are shown in red and unlocked dimensions in 
white. You can lock as many points on the curve as required. 

If you double click a span, the dialog that is displayed will 
depend on the values that are locked. The possible options 
are shown below: 
 Angle locked and Length 

locked 
No dialog displayed 

 Angle locked and Length 
unlocked 

Span Length dialog displayed 

 Angle unlocked and Length 
locked 

Span Angle dialog displayed 

 Angle unlocked and Length 
unlocked 

Span Angle and Length dialog 
displayed 
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Switch selection for arcs intersection 

Use the following model to see the effect of using the   
buttons. 

 
Using this model, try each of the following in turn:  

 With  deselected (default), move point 3 to the position 
shown below.  

  
As you move point 3, the radii A and B are constant until it is no 
longer possible to maintain the radii and alter the curve. From 
this point onwards, the radii are altered appropriately to preserve 
the integrity of the curve. 
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 With  selected, move point 3 to the position shown below. 

 
As you move point 3, the radii A and B are maintained 
throughout, moving the intersection point along the curve to 
allow the radii to remain constant. 

 

Change size of composite curve 
Use the Composite Curve Size dialog to change the size of the 
composite curve. 

 
1 Enter new values for Curve Width and Curve Height as required. If 

a dimension is locked, you will need to unlock the dimension 
before entering a new value. 

2 Select Keep proportional to maintain the aspect ratio of the curve. 
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Editing using active dimensions 
You can add active dimensions to a composite curve. An active 
dimension allows the geometry of a composite curve to be altered 
by changing the dimension value. 

1 Select a composite curve. 

2 Select  Edit the curve using active dimensions from Curve 
Editing flyout. 

 
3 The Curve Editing toolbar displays the options for editing the 

curve using active dimensions. 

 
The geometry of the composite curve is fully dimensioned. 

 
These dimensions are only displayed when the composite curve 
is selected on its own. 



 

PowerSHAPE 2015 R2 Reference Help Wireframe modelling • 225  

If you add any additional dimensions by using the Create 

dimensions manually button , these will be labelled as 
reference only. 

 
Once an active dimension is created you can drag and move it, in 
the same way as regular dimensions. The Dimension toolbar is 
available to edit the attributes of active dimensions. 

4 You can edit the curve and create various types of dimensions 
using the options below 

 Reverse the curve (see page 199) 

 Close curve (see page 202) 

 Open curve (see page 201) 

 Renumber curve points (see page 200) 

 Spline curve (see page 202) 

 Join two curves (see page 212) 

  Apply smoothing (see page 216) 

 Modify origin (see page 226) 

 Create dimensions manually (see page 226) 

 3 point radius 

 Automatic dimension 
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 Radius 

 Parallel dimension 

 Diameter 

 Major angle 

 Minor angle 

 Pick profile origin (see page 227) 

 Edit selected dimension (see page 228) 

5 To turn off active dimensions, select  at the top of the Curve 
Editing flyout. The dimensions will no longer be displayed and the 
Dimension toolbar will be closed. 

 

Active dimension commands 
There are two macro commands available when creating active 
dimensions. These generate a third point automatically to align the 
dimension with the required axis. To use, select the first two points 
and enter one of the following commands in the command window: 

auto_x  
create a dimension parallel to the X axis. 
auto_y  
create a dimension parallel to the Y axis. 

 

Modify origin 
To change the origin when dimensioning a model: 

1 Click .  

2 Move the cursor and click to position the new origin. Dimensions 
are updated accordingly. 

 

Create dimensions manually 
To manually add a dimension to your model: 

1 Click .  
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2 Click the ends of the item to be dimensioned and move the 
cursor away from the model. 

3 Click to fix the position of the text. 
 

Pick profile origin 

 - You can create dimensions manually on the composite curve 
from an origin defined by the position of the workplane which was 
active when the curve was created. 

 

Creating dimensions from the current active workplane 
To create dimensions on your wireframe from the active workplane: 

1 Double click the composite curve to display the Curve Edits 
toolbar. 

2 Select  Edit the curve using active dimensions from Curve 
Editing flyout. 

 

3 Click Create dimensions manually . The dimensions are 
displayed. 

 

4 Click Pick profile origin  
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5 Click on the composite curve at the point you want to create a 
dimension. A dimension is displayed from the origin. 

 
6 Move the cursor to the position you want and click to fix the 

dimension. 

 
 

Edit selected active dimension 

 - Edit selected active dimension - This displays the Dimension 
Value dialog where you enter the value, or parametric expression, 
for the new dimension. 

For further details, see Editing a selected active dimension (see 
page 228). 

 

Editing a selected active dimension 
To edit an active dimensions: 

1 Double click the composite curve to display the Curve Edits 
toolbar. 
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2 Select  Edit the curve using active dimensions from Curve 
Editing flyout. 

 
3 Select the dimension you want to edit. 

4 Click Edit selected active dimension . 

5 The Dimension Value dialog (see page 229) is displayed where 
you enter the new dimension value. 

 You can also double-click on the active dimension to be 
changed to display the Dimension value dialog 

 

Dimension Value dialog 

 
Value - Enter a new value to change the dimension of the geometry. 

Each linear active dimension has a start mark and an end arrow. 

 
When you change the dimension value, the start point remains fixed 
and the end point moves. 
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The value may also be set to a previously created parameter by 
right-clicking in the value box to activate the calculator. If Value is 
set to a parameter, the parameter's name and value are displayed 
as the dimension text. 

 
Reverse Direction - This changes the direction of the start and end 
points. 

OK - the wireframe model is displayed with the new dimensions. 
 

Deleting active dimensions 
To delete an active dimension: 

1 Select one of more dimensions. 

2 Either click the Delete button  or press the Delete key. 
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